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technology see SESARTIC, A., FISCHLIN, A. & TÖWE, M., 2016. Towards 
narrowing the curation gap - Theoretical considerations and lessons learned from 
decades of practice. ISPRS Int. J. Geo-Inf., 5(6): 1-30. doi: 10.3390/ijgi5060091 

https://doi.org/10.3390/ijgi5060091


Latest Additions Literature November 12, 2024 

3 

Contents 
 
1.	 LATEST CHANGES AND NEW FEATURES ......................................................................... 4	

1.1.	 Support for reading pdf and web archive files ...................................................... 6	
1.2.	 Common auxiliary data base file for journals (Journals_at_ETHZ_SE) .............. 8	

1.2.1.	 Downloading pdf and creating web archive files ............................................ 8	
1.2.2.	 Maintaining the J URLs and «NEBIS System Number» ............................... 10	

1.3.	 DOI - Digital Object Identifier ............................................................................ 15	
1.4.	 Linking to «ISI Web Of Science» via URLs containing a <Go to ISI> link ........ 17	
1.5.	 FileMaker Helper scripts ..................................................................................... 19	

1.5.1	 The scripts ...................................................................................................... 19	
1.5.2	 Recommended shortcuts ................................................................................ 23	

1.6.	 Exporting to EndNote .......................................................................................... 26	
1.7.	 Importing from EndNote ..................................................................................... 27	
1.8.	 Using BibTEX ...................................................................................................... 28	

1.8.1.	 Exporting to BibTEX files .............................................................................. 28	
1.8.2.	 Importing from BibTEX files ......................................................................... 32	

1.9.	 Using BibDesk ..................................................................................................... 34	
1.9.1	 Customizing BibDesk .................................................................................... 35	

1.9.1.1	 Setting preferences and other installations .......................................... 37	
1.9.1.2	 Recommended shortcuts ....................................................................... 50	

1.9.2	 Using BibDesk - a short tutorial ..................................................................... 54	
1.9.3	 Transferring records into and from BibDesk ................................................. 63	
1.9.4	 AppleScripts offered in BibDesk’s script menu ............................................. 64	

2.	 MAINTENANCE ............................................................................................................ 72	
2.1.	 Avoiding redundancy .......................................................................................... 72	
2.2.	 Changing the Main Key SECode ........................................................................ 73	
2.3.	 Using 0 instead of hard blank in the Main Key SECode ..................................... 75	
2.4.	 Checking FileMaker relationships ...................................................................... 78	
2.5.	 Conversion utilities ............................................................................................. 81	
2.6	 Importing into EndNote the term list Journals .................................................... 84	

APPENDIX ......................................................................................................................... 85	
A1 Acquiring new records (workflow diagrams) ......................................................... 86	
A2 Transferring records (Overviews) ........................................................................... 90	

A2.1 Transfers between EndNote and FileMaker (LiteratureMY) ........................... 90	
A2.2 Transfers between BibDesk and FileMaker (LiteratureMY) ........................... 92	
A2.3 Transfers between BibDesk and EndNote ........................................................ 93	

A3 Transferring records among applications – possibilities and restrictions ............... 94	
A4 Selecting the correct reference type Ref_Type ........................................................ 96	
A5 ISI WOS hints (browser access) ............................................................................. 98	
A6 On ISO/ANSI Standard Journal Abbreviations ...................................................... 99	
A7 Troubleshooting hints ........................................................................................... 101	
A8 Correspondence between EndNote, FileMaker, and BibDesk/BibTEX reference 

types ....................................................................................................................... 102	
A9 Correspondence between EndNote, FileMaker, and BibDesk/BibTEX fields ...... 106	
A10  Reference types and used field names ............................................................... 109	
A11 Importing: EndNote  tags and corresponding fields (from EndNote  manual) ... 110	
A12 Searching in BibDesk – Query Syntax Summaries ............................................. 112	



Latest Additions Literature November 12, 2024 

4 

A13	 Using Mendeley ................................................................................................. 115	
A14	 Kindle e-books .................................................................................................. 120	

REFERENCES .................................................................................................................. 123	

 



Latest Additions Literature November 12, 2024 

5 

1. Latest changes and new features 

A lot of changes were made to our literature management system since its original design and 
inception in 1989. Whenever there is a conflict between the previous manual (FISCHLIN & 
NEMECEK, 2001) and this document, this document overrides the previous manual.  

In previous versions a large number of menu commands were offered in the FileMaker menu 
Scripts. This is no longer the case. Efforts were made to simplify the user interface and to 
offer only the most important and most often used commands. Note, the changes were also 
kept to a minimum to stay as compatible to previous versions as possible. Most menu 
commands, now hidden can still be used2. Note, this is not the case for the scripts3 used for 
the following two features: (i) the feature to export records to an EndNote bibliography with 
master rights and (ii) the feature to split your LiteratureMY into several smaller files 
LiteratureSmallMY. These features are very complex and error prone and little used. Thus, 
they are no longer maintained and they probably contain bugs, since their support of the 
newer features such as reading pdf- and war-files has not been tested with these scripts at all. 

New scripts were added, wich support the use of the literature management system in present 
times. The situation has changed considerably since this system has been designed originally 
in1989. Services like the "Web of Science" and the fact that now most journals make articles 
available in form of pdf-files have changed significantly the environment in which we work. 
For instance it is no longer expected you only export records to BibDesk or EndNote, but don't 
import any from such bibliographies. On the contrary. The current system supports you in 
importing records via BibDesk and/or EndNote. Since many services like "Web of Science" or 
Journal web sites offer the export of information to BibDesk and EndNote, this has now 
become the standard technique to bring data into your personal LiteratureMY data base file. 
Notably BibDesk is very powerful and can create proper cite keys automatically and even 
more conveniently than the FileMaker data base can. Yet, as a data base FileMaker remains 
unsurpassed. 

The latest changes described in this document4 take all these developments into account and 
offer a more efficient management of personal references for storing and retrieval, e.g. while 
writing papers including the writing with TEX, i.e. typically with LaTEX. The new 
LiteratureMY makes it now possible for you to jump directly to an article in the internet and 
read it. Of course this requires you are currently connected to the internet at ETH Zurich (or 
you) have otherwise a valid subscription to the journal of interest.  

 
2Unless their name is marked with ' (internal)'. You should never call an internal script directly unless they are 
also marked with 'button' like in ' (internal, button)' or ' (button)'! 
3These scripts are marked with ' (use at own risk)'. 
4 As of this writing FileMaker Pro Advanced 12.0.5 to 14.0.3, EndNote X7, and BibDesk 1.6.4 under OS X Mac 
OS X 10.7.5 (Lion) to 10.11.x (El Capitan). Most of this text is still valid for the FileMaker Pro 6.0.4 running 
under earlier Mac OS versions including Classic up to version 10.6.8 (Snow Leopard). However that FileMaker 
Pro 6.0.4 version is no longer maintained (frozen at version 3.6r21). Version 3.7 or newer uses exclusively 
.fmp12 format of the FileMaker data base files, which require at least FileMaker Pro 12. Our system does not 
support the inbetween format .fp7 for FileMaker Pro versions 7 to 11. Note, FileMaker Pro 12 is the last still 
running under Mac OS X 10.6.8 (Snow Leopard). 
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A cornerstone of our system is the support for the management of a personal reprint collection 
which consists typically of a personal repository of pdf-files. Such a personal collection can 
be extracted anytime conveniently to a web site, an iPad, or burnt to CDs or DVDs in a 
format that is platform independent and reading requires only a browser and/or a pdf-Reader. 
If you annotate pdf’s also on an iOS device such as an iPad, our system offers techniques to 
sync those annotations back to your main personal pdf repository. 
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1.1. Support for reading pdf and web archive files 

It is now possible to read directly from within your data base LiteratureMY pdf-files (Adobe 
Reader portable document format), war-files (Internet Explorer web archives), and 
webarchive-files (Safari web archives). This requires to store the files under the same name as 
the main key (field SECode), e.g. Fi103.pdf or Fi103.war or Fi103.webarchive.5  

Typically you will store mostly pdf-files. The first time you attempt to access a pdf-file by 
clicking e.g. onto the button , you are asked to specify the path to the directory 
where you have stored your pdf-files with the following dialog: 

 

Use the button  to specify the directory where you store your files or enter the path in 
text form into the ochre field to the left of the button.  

If there is a 1 in the green field: , LiteratureMY expects you to have the pdf-files stored in a 
1-level hierarchical file structure, similar to this: 

 
5 This can also be conveniently done using keyboard shortcuts. See Section «Helper scripts» on how to make use 
of such a feature. 
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For a hierarchical structure, have a folder for each letter of the alphabet, as shown above for 
the letter 'A' to store all files starting with the corresponding letter. This is the recommended 
technique to store your pdf-, war-, or webarchive-files. On our server there is an archive 
XY_pdfs.sit available in Lit SE Aux Files 1.7r9 (or later). Unpack it and you get conveniently 
a folder with the needed folder structure. 

The two buttons   serve to open pdf-, war-, or webarchive-files. Both 
buttons behave very similarly. They differ only if you have a pdf-file as well as a web archive 
file for the same record. Then the first button opens the pdf-file and the second button opens 
the web archive file. In all other cases they open whatever is available.6 

Note, in some layouts the buttons to open pdf or web archive files are only visible, when there 
is actually at least a pdf or web archive file available. 

There is also an AppleScript pdfwar - Store In Letter Folder.scpt of Did_autofile.scpt in 
folder Folder Actions available. Move one of them, preferably Did_autofile.scpt, to folder 
~/Library/Scripts/Folder Action Scripts/ and activate the script for the folder where you store 
your pdf or web archive files by Ctrl-clicking onto that folder. The result will be that each 
time you move or drop a pdf or web archive file onto that folder, the file will be automatically 
stored away in the proper subfolder depending on the name of the file. To disable this feature 
anytime, simply Ctrl-click the folder and configure it differently. 

Information on the last two options shown in the layout Configure PDF/WAR 
reading/downloading are explained in the following sections of this document:  

«Downloading pdf and creating web archive files» 
«DOI - Digital Object Identifier» 

 
6 Here is assumed that you have either a war-file (Internet Explorer web archive) or a webarchive-file (Safari 
web archive), but not both present. 
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1.2. Common auxiliary data base file for journals (Journals_at_ETHZ_SE) 

Electronic journals become more and more important. Our literature data base supports the 
use of electronically published scientific articles in many ways. 

First, there is a new repeating field, called URL, in the auxiliary data base file 
Journals_at_ETHZ. It contains the journal's universal resource locater, typically a web 
address. The same field is now also shown in the LiteratureMY data base under the heading J 
URL in the upper right corner, e.g. of the standard layout. Thus, it is convenient to access the 
web site of a journal by using one of the light blue buttons7 which will open the J URL visible 
in the field right beside the buttons. 

 

There are actually two journal URLs provided (repeating field URL). The first is the link to 
the main web site of the journal, typically the current issues. The second one is for accessing 
back issues, since they are sometimes available only from a different web site, e.g. JSTOR. 

1.2.1. DOWNLOADING PDF AND CREATING WEB ARCHIVE FILES  

Note, if you use the light blue buttons  or  you have several advantages: 

1 The URL will be opened by a browser of your choice8, which is by default Internet 
Explorer or FireFox, regardless of your current system-wide browser settings. This 
offers the benefit that you can use a specialized browser for the downloading of pdf- 
or war-files. For instance Internet Explorer is fully configurable (see below).  

2 The main key of the current record is in the clipboard. Simply paste it whereever you 
like. Typically it is used for naming the pdf-file you download via the Explorer. 

3 The entry myEle is entered for you into the owners field should this be empty. 

The Internet Explorer offers the most power for configuring downloading9. It can be 
configured to handle pdf-files (File Helpers) as follows:  

 
7Alternatively you could also Command^double-click into the J URL field. Then your default browser will be 
launched instead of the "Internet Explorer" and the clipboard will of course also remain untouched. 
8You could choose also another browser than the default Internet Explorer. Use the layout Configure PDF/WAR 
reading/downloading to set the browser you wish to use (3rd. item). 
9Compared with Netscape, iCab, Camino, Mozilla. 
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- saving a web site as a web archive (war-file) 

- download pdf-files instead of viewing them in the browser10 
- ask for a destination folder for the download (Prompt), which gives you a 

chance to rename the file properly by using the main key. You find the main 
key in the clipboard. 

This is the configuration I recommend can set in Internet Explorer (Preferences... > File 
Helpers, click on Extension (top right corner) and type pdf quickly to jump to the pdf-files). 
Your dialog should then look similar to this: 

 

 
10Note, this configuration gets overwritten by Adobe Reader or Acrobat each time you launch one of these 
applications, unless you tell these applications to leave the browser alone. To this end you need to set only once 
in Adobe Reader and Acrobat the Internet preferences such that they do not "Check browser settings when 
starting Reader". This is how this preference looks in Adobe Reader v6.x:  
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Click on button  and you can edit the settings as this: 

 

Alternatively you may also set the Handling even simpler, i.e. to: 

 

war-files need no configuration. Simply save a web site and set the nesting level till which 
you wish to store the site. Similarly, in Safari choose the menu command “File -> Save As…” 
to save a web page as a web archive. 

Together with action folders, this technique offers you much convenience and efficiency 
during downloading of pdf files. 

1.2.2. MAINTAINING THE J  URLS  AND «NEBIS  SYSTEM NUMBER» 

Normally the URL of a journal is stored only within Journals_at_ETHZ. Normally, you have 
a personal copy of this file besides your personal literature data base LiteratureMY. In order 
to be able to profit from other users entering journal URLs, there is now a new mechanism 
available. If you have access to the internet, e.g. in your office at ETHZ, there is now a new 
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central auxiliary data base file, called Journals_at_ETHZ_SE, available. It allows to share 
URL data among all users by the synchronizing button "Sync J URLs". This button will 
synchronize your Journals_at_ETHZ with the central file Journals_at_ETHZ_SE. Use this 
button as follows: 

• Let's assume you wish to access the journal of a given article as described by the 
current record. You have entered all fields describing the reference, yet you don't see 
anything in the J URL field.  However, it may well be that someone has previously 
entered the journal's URL you are looking for into Journals_at_ETHZ_SE.  

• Try wether the central data base contains the wanted J URL by clicking onto the 
button  

• If the J URL contains now an URL, you are done. 

If above did not help, it means nobody has entered the J URL yet. Thus continue with the 
following steps: 

• In case the field is still empty, you should now search the URL yourself. Best use the 
ETHZ library's web sites dedicated to this task, e.g. by button  (described 
below) or by Command^double-clicking into the hot URL number 3 

    which then turns into this      
 and then navigate to the web page with the wanted journal. 
• Once you found the URL, please copy and paste it into the field J URL. Then press 

once more the button  

• From now on all other users will have the same J URL at their disposal, as soon as 
they press the synchronizing button  

Note, this means also that the rules as described in FISCHLIN & NEMECEK (2001) Section 3.6 
«Neueinträge in den unpersönlichen Hilfsdateien» are no longer valid. Note also, in your 
auxiliary file Journals_at_ETHZ are now scripts available, which allow you to conveniently 
synchronize the URLs of several currently selected records or even all records contained in 
the data base. After a succesful synchronization your file Journals_at_ETHZ should contain 
the latest ULRs from both the central data base Journals_at_ETHZ_SE as well as your local 
file Journals_at_ETHZ.Whatever URL you have entered and was newer than what is in the 
central data base, will end up there. On the other hand, some newer URL contained in the 
central data base will override that in your copy. Note, comparisons are done on a record by 
record basis, whichever record has been modified latest is the master! Be warned that any 
modification within the record will make the URL the master, regardless wether the 
modifications took place in the field J URL nor not! Again, similar to what is true for your 
records in LiterataureMY, it follows that it is recommended to synchronize frequently your 
Journals_at_ETHZ. This will minimize the risk of any loss of data. 
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There are new, handy scripts available, which allow you to easily update your local copy of 
the non-personal auxiliary file Journals_at_ETHZ (see script Download missing records from 
Journals_at_ETHZ_SE). Use this script to downloading missing records or even for a 
complete overhaul by first deleting all present records and then to download all records from 
Journals_at_ETHZ_SE. 

There is a new button  11to conveniently retrieve the needed data from NEBIS. If 
you click it, your browser should visit in NEBIS the page that corresponds to the current 
record, e.g. the journal or the book. It will use different information from the record, 
depending on availability and type of record. In case the record is a Journal Article, then the 
button tries to use first the field NEBISSysNo from Journals_at_ETHZ (This field is shown in 
the grey area to the right of the button). In this case it will directly open the web page in 
NEBIS where you can order articles from the journal12. If the record is a Journal Article and 
the button leads not directly to the corresponding journal holdings in the library, try to 
retrieve the missing information, notably field NEBISSysNo, from Journals_at_ETHZ_SE by 
using first the button . Otherwise, if the number is missing and you have 
otherwise navigated to the wanted page, please enter it into the grey area to the right of the 
button . Entering the data can conveniently be accomplished by simply clicking 
onto the greay area. Whatever is currently in the clipboard will then be pasted into the field. 
Then synchronize the journal data once more similarly as described above for URLs. 

Depending on the information available, the button  tries to use either the title, 
author information, or the so-called location or call number (in German Signatur or ETH-
Bibliotheks-Bestellnummer) to access the corresponding holdings in the library. The latter 
uses the information stored in the field TH, e.g. P 814786, and then tries to ask your default 
browser to go to that page. This way the button should make the ordering of given articles or 
books from the library considerably faster.13 

 
11TH stands for Technische Hochschule and used to be a common abbreviation for the main ETH library. 
12Alternatively you may use the button .in  the auxiliary file Journals_at_ETHZ to the same end.. 

13In case all this fails and you never reach the wanted page, or if the wanted page seems to contain only dead 
links, you have to click along all the links till you get there. To make this task easier, the new button stores 
information according to availability and priority rules into the global clipboard (try it out to learn about it). Thus 
the following sequence of links in the NEBIS system becomes more convenient: 

1) Click  

2) Click e.g.  

3) Paste the information from the clipboard, e.g. location/Signatur into the search field, e.g. Call number 

4) Select library Location ETH-BIB (Zürich) 

5) Click on button Search 
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But you should understand the following: The button  jumps directly to the wanted 
page only if the «NEBIS System Number» is known. Otherwise there is still the need to 
navigate to the wanted page by some more clicks before you will reach the wanted 
destination. Therefore, for all those pages you need to visit frequently it is recommended to 
actually store somewhere the «NEBIS System Number». This is the case for journals 
(periodica) because of the need to visit them for ordering reprints. This is the purpose of the 
new field NEBISSysNo in the auxiliary data base file Journals_at_ETHZ.  

However, for books and similar records there is no extra field to store this information. 
Instead you can use the field Bibl. (labeled TH) to this end. Attempts to store the «NEBIS 
System Number» in the grey area to the right of the button  result in a storage in field 
Bibl.14 

To summarize, these are the new rules replacing what is stated on the topic managing 
auxiliary file Journals_at_ETHZ in the first paragraph in FISCHLIN & NEMECEK (2001) 
Section 3.6 «Neueinträge in den unpersönlichen Hilfsdateien»: 

Add new records for journals only in the new central data base file 
Journals_at_ETHZ_SE.  
Except for the data mentioned in the next rule, edit existing records 
for journals only in the new central data base file 
Journals_at_ETHZ_SE.  
Edit J URL information and/or the «NEBIS System Number» only 
directly within your personal LiteratureMY and once finished press 
button . 

Synchronize frequently Journals_at_ETHZ with 
Journals_at_ETHZ_SE15 

 

 
6) Click on the 2nd entry in the presented list 

If all this should still fail, NEBIS sometimes is really confused, use first link  before repeating above 
steps. By the way, if the library staff supports me, I will make efforts to get the new blue button  
working fully so that all steps described above will no longer be necessary. 
 
14The previously stored location number is not lost. It is stored in a hidden, repeating field. This field is visible 
in the layout "Maintainer's layout". 
15Use the many convenient scripts from Journals_at_ETHZ provided for this purpose. 
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or alternatively 
Download all records from Journals_at_ETHZ_SE into your 
Journals_at_ETHZ after having deleted the old records there first. 
Never delete anything in Journals_at_ETHZ_SE unless there is a 
definite need, e.g. removal of a faulty record. 

Remember when entering new journals into Journals_at_ETHZ_SE to abbreviate them 
correctly, i.e. according to the ANSI rules. Good sources for journal abbreviations are: 

FISCHLIN, 2001 Appendix H, p.40ff. 
http://cassi.cas.org/search.jsp  (also available as one of the Hot URLs in LiteratureMY) 

and then see Appendix A6 

Finally, note that the field ISBN (on standard layout labelled ISB/SN) serves to store ISBN 
for books and ISSN numbers for journals. This is different from earlier versions of our data 
base and you may wish to relookup journals to enter the ISSN for records where it is missing. 

http://cassi.cas.org/search.jsp
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1.3. DOI - Digital Object Identifier 

The field DOI, i.e. Digital Object Identifier field, is now fully supported. A DOI is a unique 
identifier permanently associated with a particular journal article. It allows to jump directly to 
the web site where the journal article is published. You can control which browser is used16. 
Of course this is only possible if you have the access rights to read that journal. Use the green 
DOI-button to accomplish this: 

 

The field DOI may contain only the DOI or may be preceeded by the preifx "doi:". It may 
even contain an ordinary internet URL starting with "http://", e.g. "http://dx.doi.org/...". In all 
these cases the button  will attempt to jump directly to the location the field refers to. 
Note, this button is in many layouts only visible, when the field DOI actually contains some 
DOI information. 

In case the field DOI is empty, the button will try to extract a DOI from the field URL. In case 
that neither the field URL nor the field DOI contain a DOI number, the button's algorithm will 
try to extract a <Go to ISI> number from field URL and try to link to the associated record in 
«Web Of Science» (see Section below „Linking to «ISI Web Of Science» via URLs containing 
a <Go to ISI> Link”). If the latter attempt fails, but the field URL contains a valid URL 
starting with "http://" an attempt will be made to go to this web site. Only if all these attempts 
fail an error message will be displayed. 

To resolve a DOI go to: 

• http://dx.doi.org/ or http://www.crossref.org/05researchers/58doi_resolver.html 
• Our shadow home page http://www.sysecol.ethz.ch/Internals.html offers a resolver 

button (Get by DOI) which allows you to enter a DOI and jump to it. 
• Such a resolver button can also be installed in your won browser. You find all you 

need for this here:  http://www.doi.org/tools.html 

 
16You can control whether the system wide default browser is used or the same browser that LiteratureMY uses 
for downloading pdf-files. Use the layout Configure PDF/WAR reading/downloading to set that preference. If 
you wish that the DOI button  uses the system wide browser (default), use the value  under the 4th. item, 
otherwise enter value 1. 
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To learn more about DOIs in general visit: 

• International DOI Foundation (IDF): http://www.doi.org/index.html 
• Content Directions, Inc.: http://www.contentdirections.com 

• Corporation for Nat’l Research Initiatives (CNRI): http://www.cnri.reston.va.us 
• CrossRefConsortium:  http://www.crossref.org 

• DELLAVALLE et al., 2003 
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1.4. Linking to «ISI Web Of Science» via URLs containing a <Go to ISI> link 

The script "Go to ISI"17 or the button  does now also support the direct linking to 
associated «ISI Web Of Science» records, given the field URL contains some information of 
the following kind: 

 <Go to ISI>://000182481700001 

Check in Maintainers Layout the content of field GotoISIBaseURL in LiteratureMY, in case 
you encounter problems using this feature18. 

Note, if you use the button  and the field DOI contains a valid DOI, the latter is used to 
link to the article on the web. However, you can still force the link to «ISI Web Of Science» 
by directly clicking onto the field URL or choosing the menu command Scripts > Go to ISI or 
URL19. 

Note, links of this kind are also supported from within EndNote. However, to ensure that 
these links do really work you need to set the field ISI Base URL in the EndNote preferences 
Online as shown below: 

 

 
17May need to be first activated in order to perform this script via menu command Scripts > Go to ISI. 
Alternatively click onto the URL field containing the URL. 
18'http://gateway.isiknowledge.com/gateway/Gateway.cgi?GWVersion=2&SrcAuth=ResearchSoft&SrcApp=En
dNote&DestLinkType=FullRecord&DestApp=WOS&KeyUT= (as of August 2016) 
19Given this helper script is currently available from your scripts menu (see Section «New Helper Scripts»). 
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Note also, you may encounter a situation where you have many URLs available, e.g. a <Go to 
ISI> Link as well as a PURL (Permanent/Persistent Universal/Uniform Resource Locator), a 
URL for the DOI of the form http://dx.doi.org/…, or any other URL (Universal/Uniform 
Resource Locator). The rcommendation is to not waste the field URL for a DOI, since there is 
the field DOI available for that purpose. If the field URL contains such a DOI link, simply 
choose the menu command Scripts > Maintenance > Fix URL (replace 'http://' form by '<Go 
to ISI>://'), prefix 'www.' by 'http://') and it will extract the DOI and store it safely in the field 
DOI. Otherwise favor a real PURL over <Go to ISI> Link or another URL, where the latter is 
most likely the least stable.20 

Note that reports may require special treatments, since many lack a DOI. The 
recommendation then is to use field URL to hold the URL to the web site where the report is 
described. Store in the field DOI then a deep link to the pdf. Since the latter is typically the 
least stable, this approach increases the probability to be able to locate the report while 
providing maximum convenience and flexibility for citing. 

Special treatment may be required for own publications and Systems Ecology Reports, where 
the field URL should contain an URL to the web site of Systems Ecology, i.e. 
www.sysecol.ethz.ch/publications. Please choose for such publications the menu command 
Scripts > Maintenance > Fix URL and DOI for SE publications to make sure the content of 
fields URL as well as DOI conform to our standards. 

 
20 Aforementioned FileMaker script will also detect whether there are multiple URL’s stored in field URL. In 
such a case the script should be able to conveniently detect and extract a DOI as well as favor URL’s according 
to this recommendation. 

http://www.sysecol.ethz.ch/publications
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1.5. FileMaker Helper scripts 

1.5.1 THE SCRIPTS  

There are several handy helper scripts available, which make your work with references 
considerably more efficient, notably when you make them available via keyboard shortcuts 
(see below).  

Duplicate record This is the script which should be used to duplicate a record. Never 
use FileMaker's menu command Duplicate Record or you are likely to encounter all 
sorts of irksome or even confusing alerts. This script helps you much in case you 
want to enter many records containing similar information. E.g. several articles in an 
edited book, several articles in the same issue of a journal, or a new edition of a 
book. 

Mark for electronic ownership Inserts in the owner list an entry of the form afEle. This 
is done in a data base user specific manner. Note, however, constructs like afPdf are 
not supported. Moreover, this script clears the Comment if it appears to contain only 
some redundant text on the journal. The latter is often the result if you download 
references from ISI Web Of Science. 

Undo clear of comments by above mark script If you have accidentally deleted the 
comments, this is an undo command for that side effect of Mark for electronic 
ownership. Note, this undo works only as long as you do it immediately afterwards. 

Paste DOI pastes the current content of the clipboard into field DOI. Note, this trims 
and removes extra characters not belonging to the actual DOI. Thus a simple double-
click onto a DOI shown in the browser followed by a Cmd-C may be sufficient to 
get a proper, i.e. functioning DOI. 

Go to article by DOI is the same as clicking button  (see Section «DOI - Digital 
Object Identifier»). Having a script offers in OS X21 the advantage of defining a 
keyboard shortcut in the Systems Preferences pane Keyboard & Mouse (see below). 

Go to ISI (see Section „Linking to «ISI Web Of Science» via URLs containing a <Go to 
ISI> Link”) 

S·F·X is the same as clicking button . If the current record is a a journal article and 
field ISB/SN contains a valid ISSN, this script will open in the default browser a 
search mask to find the article using the SFX service of ETH Zurich, i.e. the 
Context-Sensitive Reference Linking service. Having a script offers in OS X22 the 
advantage of defining a keyboard shortcut in the Systems Preferences pane 
Keyboard & Mouse (see below). 

Open pdf is the same as clicking button  (see Section «Support for Reading 
pdf- and war-files»). In case some supplementary material is present, having the 
same file name as the pdf, but ends with “_S.pdf”, then that file is also opened. This 

 
21as of Panther 
22as of Panther 
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script allows to use a shortcut, for instance the same as EndNote is using, i.e. ⌘ ⌥ P 
(Command-Option-P). 

Reveal pdf in Finder23 is the same as clicking button . This script opens in the Finder 
the folder where the linked pdf resides and selects it. In case some supplementary 
material is present, having the same file name as the pdf, but ends with “_S.pdf”, 
then that file is also selected. This script allows to use a shortcut similar to the one 
used to open pdf’s, e.g. ⌘ ⌥ = (Command-Option-=). 

Duplicate pdf(s) for e-Reading is similar as clicking button , the only 
difference is that the script works for all currently selected records while the button 
works only for the current record. The script duplicates any linked pdf’s or other 
electronic documents from your main pdf repository to a folder, which an e-reader 
such as an iPad or an iPhone can access. Typically such a folder resides on a cloud 
service such as Dropbox24 or SugarSync25. Use layout Configure PDF/WAR 
reading/downloading to choose that folder. If you annotate your pdf’s on the iPad, 
e.g. using App GoodReader26, you can synchronize pdf’s back to your Mac using 
this very same folder. In BibDesk there are companion AppleScripts available: 
Extract for e-Reading and Sync Back from e-Reading. Extract for e-Reading does 
more than merely duplicate pdf’s into the e-Reading folder, since it also extracts 
meta data and creates a bibliography file in html format, which can be read with any 
browser. Sync Back from e-Reading serves the synchronization purpose and brings 
back into your main pdf repository any pdf that you may have altered by annotations 
including support for pdf’s linked to publication records by symbolic links and/or 
aliases. The latter is a technique I use to store complex in collection works where 
each contribution, say a chapter or special issue article, needs also to be cited 
separately. The pdf’s of the collection are all kept within the same folder named after 
the collection’s cite key and symbolic links are then kept wherever they belong (cf. 
BibDesk AppleScript Make PDF Alias27). 

 This calls for some explanations: These scripts serve me well, since I have a huge collection of 
literature I do not wish to synchronize entirely all the time with my e-Reader (by the way an iPad). 
Therefore I prefer to have only an excerpt of the files on my e-Reader, i.e. the pdf’s I am currently 
reading. The huge collection of pdf’s stays mostly on my Mac in my main pdf repository. This means 
also my use of an e-Reader depends on no cloud service with large storage capacity. Despite having 
one intermediate step by using an e-Reading folder, syncing is almost as convenient as if I would 
synchronize my entire pdf repository with a cloud service such as Dropbox or SugarSync. Note, with 
this approach only the e-Reading folder is synced automatically with your portable devices using a 
cloud service. You have full control of what remains on your Mac’s main pdf repository and what is 
synced with mobile devices. However, the drawback of this approach is that you need some discipline 
with which files you are annotating where to avoid annotation conflicts. But the rule to run Sync Back 
from e-Reading just before annotating on the Mac suffices to avoid any such conflicts.  
  Alternatively you could also use tools such as Synchronize! X Plus or Synchronize! Pro X 
from Qdea28 to keep your pdf’s in sync, e.g. by synchronizing regularly recent modified pdf’s 

 
23 May not be active by default factory settings, activate it if you wish to use it, e.g. via a shortcut. 
24 Available from http://www.dropbox.com/ and Apple’s App Store 
25 Available from http://www.sugarsync.com/ and Apple’s App Store 
26 Available from Apple’s App Store or http://www.goodiware.com/goodreader.html  
27 This AppleScript is actually not distributed together with the BibDesk AppleScripts, but provided with 
distribution of package EndNote SE Add Ons… However, if you use both the EndNote Utilities as well as as our 
BibDesk Support Package, then the installer of the latter makes this AppleScript also available from within 
BibDesk. 
28 Available from http://www.qdea.com/  

http://www.dropbox.com/
http://www.sugarsync.com/
http://www.goodiware.com/goodreader.html
http://www.qdea.com/
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between your main pdf repository and the e-Reader folder. However, such an approach would not 
support the use of symbolic links or aliases within your main pdf repository and I therefore strongly 
recommend using only above mentioned BibDesk AppleScripts. They sync a complex pdf repository 
much better than any of the commercially available software I know of.  

Paste Summary pastes the current content of the clipboard into field Summary. Similar 
to Paste DOI the result is a neatly trimmed summary, even if you have made a 
sloppy selection including blanks at the begin and end of the actual summary text. 

Copy SECode copies the content of field SECode into the clipboard, e.g. for pasting it to 
a filename in the Finder or other similar uses. 

Copy records as SECode list into clipboard29 copies from all records in current selection 
the content of field SECode as a comma seperated list into the clipboard. See also the 
reverse script Find records from SECode list in clipboard that can be used with such 
a list in the clipboard to find the listed records. 

Compare SECode list in clipboard with current set compares the current set of records 
with the comma separated list of SECode’s in the clipboard and puts possibly found 
differences into the clipboard. The script expects a comma separated list of 
SECode’s exactly as produced by the companion script Copy records as SECode list 
into clipboard. Its result can be directly used with script Find records from SECode 
list in clipboard to find the records that are unique to the originally found set of 
records. 

Find records from SECode list in clipboard30 finds the records as listed by their SECode 
in the clipboard. The script expects a comma separated list of SECode’s exactly as 
produced by the reverse script Copy records as SECode list into clipboard or by 
script Compare SECode list in clipboard with current set. In the latter case it 
searchres only for those records that are unique to the FileMaker data base. 

Replicate keywords to all records in current set does replicate from the current record 
all keywords to all other records in the current set. Before using this script make sure 
all records in the current set should really obtain identical keywords, since any 
existing keyword on any other record will be overwritten and you can't undo this 
action. 

Make "cf. "-list of SECodes from currently selected records does creates a list of all 
SECodes, i.e. the so-called “cf. …” list, from all currently selected records in the 
field Comments of all currently selected records. Ex.: If two records are currently 
selected that have these SECode values: Be246 and Cr68, the result of this command 
is that following string  
 
  cf. Be246, Cr68 
 
is inserted as an additional line in the field Comments of both records. The advantage 
of this is that you can easily search a set of records thus related using the next helper 
script. 

Find records from "cf. ..." list of SECodes in field Comments finds all records that are 
related by a common “cf. …” list in the Comments field as created by the previous 
helper script. If your field Comments starts with an entry such as “^Fi103”, the text 

 
29 The companion AppleScript with the same functionality in BibDesk is: Selected To Clipboard (Cite Key List) 
30 The companion AppleScript with the same functionality in BibDesk is: Select From Clipboard (Cite Key List) 
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after “^” is interpreted as the SECode of the record of a work in which the current 
reference has been cited and this script will find that related record. 

Add this record to current find does add to the current find the SECode from the current 
record for subsequent finding. This script is particularly handy while using a shortcut 
such as Ctrl-¬ (Ctrl-<cursor left>), since the shortcuts Ctrl-¯ (Ctrl-<cursor down>) 
and Ctrl- (Ctrl-<cursor up>) are standard FileMaker shortcuts to move to the 
previous or next record. 

Perform current find executes the current find. This script is particularly handy while 
using a shortcut such as Ctrl-® (Ctrl-<cursor right>) (see also above Add this 
record to current find). 

Show these publications in BibDesk searches and selects in BibDesk’s current top 
document all publication(s) that correspond to the currently selected records. 
Matching is done by matching cite keys with the SECode’s from all currently 
selected records. This script is particularly handy while using a shortcut such as 
Ctrl-H and has a counterpart script in BibDesk, i.e. AppleScript Show In 
LiteratureMY, for which it is also recommended to use the shortcut Ctrl-H. 

 Note the buttons 

  
operate only on a single, i.e. the currently shown record. Otherwise the right button 
“Show same …” “in BibDesk” does the same as this script. 

Replicate current 'InUseFor' value to all records in current set does replicate the 
currently selected entry in field InUseFor to all other records in the currently 
selected set. The entry is inserted at the top after having shifted all other possibly 
present entries one position down. Be warned, this means of course you may lose in 
some records some entries, i.e. the last one, if all seven repetitions of field InUseFor 
hold an entry before the new is added. 

Free first entry in field 'InUseFor' in current set shifts all entries in field InUseFor by 
one repetition down to free some more space at the top of the list for a new entry. Be 
aware that this helper script does operate on all currently selected records. If any of 
your records holds already a value in all 7 repetitions, the last entry will be lost for 
those records. 

Cleanup field 'InUseFor' in current set discards duplicate entries and gaps in field 
InUseFor. This helper script does operate on all currently selected records. Note, to 
cleanup the field InUseFor for an individual record, switch to Maintainers Layout 
and click button . 

Cleanup field 'Owners' in current set discards duplicate entries and gaps in field 
Owners. This helper script does operate on all currently selected records. Note, to 
cleanup the field Owners for an individual record, switch to Maintainers Layout and 
click button  below the bottom of the column of reprint owners. 

Delete record permanently deletes the currently selected record permanently by also 
deleting all corresponding records in the central data base. Use this script only if you 
are on-line and the central data base LiteratureSE is available! This is the 
recommended method of deleting records from your data base. Refrain from simply 
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using FileMaker’s standard menu command “Records -> Delete Record…”; use this 
script instead to avoid inconsistencies in your data base. 

Note, some of these helper scripts may not be active by default or may be grouped within a 
submenu. You may need to access first the submenu to choose those commands or even 
activate them first.31 Others may not be useful to you and you may prefer to deactivate them. 
Thus, customize them to your liking and working style. 

1.5.2 RECOMMENDED SHORTCUTS  

Many of these helper scripts become really useful if they can be triggered with a keyboard 
shortcut. I suggest e.g. to use the following shortcuts:  

 

How to set these shortcuts? As of Mac OS X Panther (v 10.3.x) the OS supports the 
customization of any native application32. Thus, thanks to OS X you can go beyond the 
restrictions of FileMaker, which supports by itself shortcuts only for the first ten scripts (⌘ 1 
.. ⌘ 0). 

 
31 Choose menu command Scripts > ScriptMaker... and check or uncheck the option "Include in Menu" for the 
scripts you wish to hide or access from the Scripts menu. Besides, unless you know exactly what you do, refrain 
from activating scripts ending with “ (internal)”, since they should never be called directly or you risk failure. 
32 Albeit FileMaker Pro 6.0.4 is not a Cocoa application, it is a native Carbon application and can still be 
customized. Mac OS X 10.3.9 (Panther) required to customize all commands in one go and was limited in the 
possibility to edit the shortcuts. Under Mac OS X 10.5.8 (Leopard) and later the customization is fully functional 
and works for FileMaker Pro 6.0.4 and all later versions as conveniently as for any other application. 
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Use the Systems Preferences pane Keyboard & Mouse to set your keyboard shortcuts. This 
should look similar to the following:  

 

Hint: To avoid typos, copy and paste the script names from FileMaker to the System 
Preference Pane and switch back and forth between the two applications. To this end open 
first FileMaker’s dialog window by choosing menu command “Script -> ScriptMaker…”. If 
you use that menu command often, this is also the moment to assign to it the shortcut Ctrl-0. 

 

 

In fact I find it useful to customize even further scripts, e.g. the one sorting in reverse 
chronological order brings you the most recent records to the top of your current selection. 
Here a list of all the shortcuts I work with daily and which facilitate in my experience the 
work considerably: 
 

^0 ScriptMaker… 
^C Sort chronologically in reverse order 
^6 Export to BibDesk 
^7 Import from BibDesk 
^D Duplicate record 
^M Mark for electronic ownership 
^V Paste DOI 
^G Go to article by DOI 
⌥⌘P Open pdf 
⌥⌘= Reveal pdf in Finder 
^A Paste Summary 
^K Copy reference formatted 
^+ Copy Compare SECode list in clipboard with current set into clipboard 
^- Compare SECode list in clipboard with current set 
^S Find records from SECode list in clipboard 
^R Replicate keywords to all records in current set 
⌥⌘K Save original keywords in field 'Comments' 
^U Replicate current 'InUseFor' value to all records in current set 
^F Find records from "cf. ..." list of SECodes in field Comments 
⌥⌘← Inite current find 
^← Add this record to current find 
^→ Perform current find 
^H Show these publications in BibDesk 
^L Find last imported 
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FindInconsistencies: 
 
^⌘R Refind the inconsistent 
^⌘M Show related record in LiteratureMY 
^⌘P Open folder and reveal PDF in Finder 
^⌘H Show current record in BibDesk 

The distribution contains also the double-clickable shell script Install-FM-hotkeys.command, 
which allows to assign all these shortcuts in one easy go. However, under macOS 13.7 
(Ventura) using FileMaker Pro 19 version 19.6.3 it is recommended to quit at least FileMaker 
Pro while executing that script and you may even have to restart the system to get all 
shortcuts assigned properly. It may also be that you have to fix some of those shortcut 
definitions manually as it seems that the assignment by the shell script for shortcuts involving 
cursor keys does not always fully work reliably for some menu commands such as Inite 
current find, Add this record to current find, or Perform current find. 
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1.6. Exporting to EndNote  

The export to EndNote from your personal FileMaker data base was slightly modified: By 
default records are no longer marked as having been exported. As a consequence you can 
freely export records in large quantities to EndNote without having to upload/merge all 
involved records later to the central data base LiteratureSE. Previously any export to EndNote  
modified the involved records by marking them with the export date, which consequently lead 
to this behavior. The latter is quite cumbersome in case of a large data base. Should you 
prefer the old scripts, they are still available, but by default not shown in the menu "Scripts". 
If you wish to activate any of them, choose the menu command "Scripts -> 
ScriptMaker...".and check the script you wish to see in the menu "Scripts". 

There are also several scripts available, which export records to EndNote (see Appendix A2 
«Transferring records (Overviews)»). Under Mac OSX it is now also possible to trigger the 
entire transfer into EndNote or at least the conversion done by the EndNote menu in AlphaX. 
These features assume you have all necessary software pieces installed properly (EndNote 
menu in AlphaX, AppleScript, EndNote). The older scripts are still available, but they are not 
shown by default in the menu "Scripts".  

The complex transfer scripts work only successfully if you have a proper installation. Make 
sure to follow religiously the installation instructions given in file READ ME EndNote SE 
Add Ons.rtfd as released with the latest package EndNote SE Add Ons. 
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1.7. Importing from EndNote  

As of version 2.9r0 and later of LiteratureMY you may now directly import records from an 
EndNote bibliography to your personal FileMaker data base under OS X. From within 
LiteratureMY simply choose the new menu command "Scripts -> Import from EndNote (do 
entire transfer and quietly import file 'refs.out')". Any currently selected records in the 
topmost EndNote  bibliography are transferred. In case there are no records selected, all 
records shown will be transferred. This new feature replaces the previously available 
launching of the AppleScript application 'EN2FM.app' (see also Appendix A2 «Transferring 
records (Overview)»). This new feature will only work flawlessly if you have all necessary 
software pieces properly installed (EndNote menu in AlphaX, AppleScript, EndNote). The 
older script "Scripts -> Import from EndNote (quietly from file 'refs.out')" is still available, 
but is no longer shown by default in the menu "Scripts".  

Such a transfer is complex and involves many steps running invisibly in the background, and 
works only successfully if you have a proper installation. Make sure to follow religiously the 
installation instructions given in file READ ME EndNote SE Add Ons.rtfd as released with the 
latest package EndNote SE Add Ons. 
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1.8. Using BibTEX 

LiteratureMY can easily generate traditional BibTEX files to use them in whichever manner 
you like. BibTEX files are ASCII text files and are typically required to manage references 
while writing documents with TEX or LaTEX. However, to achieve full collaboration between 
the LiteratureMY system and BibTEX files, it is recommended to use the great open source 
application BibDesk33. BibDesk allows you to conveniently manage BibTEX files in many 
ways. BibDesk is very powerful and offers many more features as partly described below 
(Section «Using BibDesk»). This section is dedicated to the traditional use of BibTEX files, 
but is also of interest if you use BibDesk, since BibDesk stores its information in a manner 
that is fully compatible to the BibTEX standard. Details on this format and how it relates to 
the LiteratureMY system are provided in this, the actual use of BibDesk in the next section. 

Note, the export of the traditional BibTEX files is still fully supported under Classic. 
However, since BibDesk is only available for OS X, the LiteratureMY system makes use of 
OS X in many respects, notably when cooperating with BibDesk. While exporting of BibTEX 
files from LiteratureMY is supported for all operating systems, transferring records back to 
LiteratureMY or other helpful features offered by LiteratureMY, such as auto-filing (see 
Section «Using BibDesk») etc. are no longer available under Classic. 

1.8.1. EXPORTING TO B IBTEX  FILES  

First a direct, simple and efficient exportFirst a direct, simple and efficient export of 
references to traditional BibTEX files is provided by LiteratureMY. You can export references 
to the BibTEX format by using in the FileMaker data base LiteratureMY the script «Export to 
BibTEX...»34: This exports all currently selected references to a so-called BibTEX file, i.e. a 
file with the fixed name refs.bib (note extension ".bib" to be used for all BibTEX files)35 
residing within your Literature work folder^. In case you wish to add some references to an 
already existing BibTEX file, use application BibDesk (see also next Section on «Using 
BibDesk») or merge them manually, e.g. by using the editor AlphaX36. To edit the content of 
such a file in detail use either BibDesk (described below) or the editor AlphaX. 

 
33 A great open source application available from http://bibdesk.sourceforge.net/ 
34 This script is by default not shown in the menu. Instead «Scripts -> Export to BibDesk» is available in the 
menu by default. 
35For this to succeed when using LiteratureMY while having booted into OS Classic, the presence of utility 
FMtoBibTeX is required in the same directory where LiteratureMY resides. Otherwise the export script will 
merely create a file refs-temp.bin. The latter needs to be formatted properly in order to become a real BibTEX  
file. Note also, BibDesk can't open successfully the refs-temp.bib file. Always run first FMtoBibTeX to create 
refs.bib or then replace manually all characters 13C for characters 15C. 
^ The location of this folder can be freely chosen according to your liking. However, to allow these scripts to 
know where this folder resides, you need to have a little text file name ‘LITMYPath.txt’ in the bin directory in 
your home directory (~/bin/LITMYPath.txt) that exports the shell variable LITMY pointing to the location of 
your directory. Such a file is provided (distributed within a disk image with name containing EndNote SE Add 
Ons…) and automatically installed if you install the recommended EndNote utilities. However, you may need to 
update its content according to your actual system setup. 
36 The Tcl extendable editor for power users: http://alphatcl.sourceforge.net/wiki/pmwiki.php/Software/AlphaX 
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The following relationships hold between reference types (Ref_Type) and entry types in 
addition to what is stated in FISCHLIN & NEMECEK (2001, p. 26-29) for the most commonly 
used reference types:  
 

LiteratureMY v>=1.8r5 BibTEX37 EndNote 7 (SE)38 EndNote 7 (default39) 

Journal Article article Journal Article (140 ) Journal Article (1) 
Book book Book (2) Book (2) 
In Edited Book incollection In Edited Book Magazine Article41 

Note, that ambiguities arise, since a perfect mapping of the reference types among the various 
systems is not possible. A complete list of all reference types available as of this writing is 
given in Appendix A8 «Correspondence between EndNote, FileMaker, and BibDesk/BibTEX 
reference types».  

The meaning of the fields is described in KOPKA & DALY (2003, p. 232-233). Some fields, 
notably extensions of the BibTEX standard42 by BibDesk are also listed here. The following 
correspondence between fields will be observed by the transfer scripts:  
 

LiteratureMY v>=1.8r5 BibTEX43 EndNote 44 (Generic45) 

Ref_Type entry type Reference type 
SysEcolCode cite key46 (citation key) Label47 
Authors author Author 

 
37In BibTEX reference types are called entry types 
38Customization of reference types needed for proper transfer from FileMaker data base LiteratureMY to 
Endnote and vice versa. Moreover, you need the editor Alpha's menu package EndNote to accomplish the 
transfer. This means in practice: With EndNote versions older than EndNote X1 you need to copy the EndNote 
preferences to your Preference folder exactly as distributed with our personal literature data base software 
afp://se-server.ethz.ch/SE_Intern/Literature/ (distributed within a disk image with name containing EndNote SE 
Add Ons…). As of EndNote X1 you no longer need to customize the reference types in such a cumbersome way: 
You can conveniently import the needed reference types. Secondly install in the AlphaX editor the menu package 
EndNote by double-clicking the installer file. The latter comes again with this same software distribution (on 
disk image EndNote SE Add Ons…). For details see the installation instructions also available within this 
distribution and in this documentation Appendix A2 «Transferring records (Overviews)». 
39The listed reference types are those of EndNote's factory settings, i.e. the so-called EndNote Defaults. 
40The numbers correspond to the sequence in which the reference types are listed in EndNote. 
41 In later EndNote versions the reference type Unused 1 is customized and used for type In Edited Book. 
42 Described nicely at http://nwalsh.com/tex/texhelp/BibTeX.html  
43"Official" BibTEX fields are listed in bold 
44 Does apply to EndNote v7 and later versions. Upward compatibility given, since later EndNote versions have 
mostly just added fields 
45 Only the so-called generic field names are listed here. Since EndNote field names can be changed/customized, 
the actual names differ from the ones listed here (see also Appendix A9 «Correspondence between EndNote, 
FileMaker, and BibDesk/BibTEX fields»). 
46 Orignal BibTEX name of this field is merely key, while BibDesk names it well cite key 
47Listed here out of sequence because of its prominent role as main key of the data base (only true for 
LiteratureMY and BibTEX, but unfortunately not so for EndNote, which knows no true main key. The reference 
number is not associated with a particular record and may too easily change! The big drawback of EndNote.) 

http://nwalsh.com/tex/texhelp/BibTeX.html
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Year year Year 
Title title Title 
Editors editor Secondary Author 
JOrPubl 48 journal, booktitle Secondary Title 
City address Place Published 
Publisher publisher, organization, 

institution, school, 
howpublished 49 

Publisher 

Vol volume Volume 
Microfiche custom5 * Number of Volumes 
No. number Number 
pp pages Pages 
SeriesEditor custom5 * Tertiary Author 
SeriesTitle series Tertiary Title 
Edition edition Edition 
PlaceDate month 50 Date 
TypeOfWork type Type of Work 51 
Owners custom5 * Reviewed Item 
Bibl. B custom5 * Call Number 

 
48 The field Journal (not FullJournal, which is basically omitted from exports, since it can be reconstructed from 
field JOrPubl anytime) is written to field journal if the record is a Journal Article, Newspaper Article (or 
magazine article), or Edited Articles, to field booktitle in all other cases (InBook, In Edited Book, 
In Proceedings). 
49The field Publisher is written to field school if the record is a Thesis, to field institution if the record is a 
Report or Edited Report, to field organization if it is a In Proceedings, Proceedings, or Tech Report, to field 
howpublished if the record is a booklet or misc, to field publisher in all other cases. 
* BibTeX tolerates any non-standard field in its data base and BibDesk supports even their editing! However, the 
XML export to EndNote has limitations and therefore using non-standard fields within BibDesk can result in 
data loss when attempting to export data out of BibDesk. Thus exporting from LiteratureMY to BibTeX supports 
all standard BibTeX fields and then uses a minimum number of additional special fields to store the extra 
information. Among these is note-worthy field custom5 reserved for internal use. LiteratureMY offers no such 
field, yet during exporting, several fields from LiteratureMY are packed at once into the BibDesk field custom5 
to avoid any data loss when transferring records back and forth between BibDesk and LiteratureMY. 
50The LiteratureMY field PlaceDate is stored in BibTeX field month for reference types Proceedings, 
In Proceedings, or Edited Articles, the latter being e.g. a special issue serving as proceedings of a conference. 
PlaceDate contains two types of data: First the place or location where the conference took place, secondly the 
date of the conference, inbetween a semicolon as delimiter. Ex.: “Athens, Greece; January 2-4, 2015”. Patashnik 
(1988, p.7) recommends to use the BibTeX field address for storing the conference place. However, we always 
use BibTeX field address to hold only the publisher’s address. You could use the optional BibTeX field location 
for that purpose, but then you risk to lose that information when transferring records between BibTeX and the 
FileMaker LiteratureMY data base. Note, BibTeX field month is recognized as optional for aforementioned 
reference types. Thus we recommend to use it always for storing the conference date. 
51 In case of a Journal Article, Newspaper Article, or Edited Articles the field TypeOfWork may contain some 
section information, e.g. "Editorial" or "Letters" for the corresponding sections in the Science magazine. 
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ISBN isbn ISBN/ISSN 
Users custom5 * Custom 1 
Ref_Status custom5 * 

(Custom 2) 52 
Custom 2 

Entry_Date custom5 * Custom 3 
Modified custom5 * Custom 4 
- * custom5 * Custom 5 
Custom_6 custom5 * Custom 6 
Custom_7 custom5 * Custom 7 
DOI 53 doi 54 DOI 
Bibl. B custom5 * Call Number 
Keywords keywords Keywords 
Summary abstract Abstract 
Project encoded within annote ‡ Notes 
InUseFor encoded within annote ‡ Notes 
StoragePlace encoded within annote ‡ Notes 
InCrdIndex encoded within annote ‡ Notes 
Comments annote 55 Research Notes 

 
B Since the FileMaker data base LiteratureMY was designed before EndNote offered the field Call Number, the 
field Alternate Title was used to store that information. As of EndNote 7 the field Bibl. is stored in field Call 
Number. 
52 The field Custom 2 (custom2) is reserved for internal use only. In BibDesk custom2 stores the fact that a 
record was newly acquired in BibDesk and that its cite key was not generated in LiteratureMY but in BibDesk 
(holds marker ‘fromBibDesk’). Once the record has been transferred to its final storage in LiteratureMY, this 
field custom2 is emptied and the marker is transferred into LiteratureMY field InCrdIndex for permanent storage 
(using phrase ‘BibDeskEntered’). Instead in LiteratureMY the field Ref_Status holds now the ordinary status of a 
record, the status as preserved in BibDesk field custom5. As a consequence you should refrain from editing field 
Custom 5 (custom5), neither in BibDesk, nor in EndNote, to avoid the risk of disturbing the automatic processing 
and full preservation of all data during any record transfers. 
53 Can also hold an ordinary URL and serves within FileMaker data base LiteratureMY to store a 2nd URL if no 
DOI is available for this record, which is often the case for older publications, which then may have associated a 
so-called stable URL, as e.g. provided by JSTOR. 
54 BibDesk gives this field also special treatment and considers it similar to a URL 
‡ Since the FileMaker data base LiteratureMY was designed before EndNote offered a sufficient number of 
fields, this field together with others needed to be summarized in a single EndNote field when transferring from 
FileMaker to EndNote. First we could use only EndNote field Notes for that purpose and we kept this technique 
for backward compatibility reasons. On the other hand, BibTeX uses field note for specific purposes, i.e. its 
content typically ends up in the BibTeX generated list of references and BibTeX field annote corresponds actually 
best with FileMaker field Comments. Therefore the contents of the FileMaker fields Project, InUseFor, 
storagePlace, and InCrdIndex are stored in BibTeX field annote after reserved keywords “ProjectUse: “, 
“InUseFor: “, “StoragePlace: “, “InCardIndex: “ (or “AlsoOnIndexCard” not followed by any data) at the very 
end of BibTeX field annote. 
55 Do not confound the field note with field annote. The content of field note is by default always added to a 
reference in the generated list of references. This is not the case for field annote, which is reserved for special 
lists, i.e. annotated lists of references. However, BibDesk respects in field annote line breaks, not so in the field 
note. The latter’s content is always filled and wrapped, and you therefore would lose any end-of-line information 
during transfers. Fortunately, field annote does respect line breaks and for all these reasons is therefore better 
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URL url 56 URL 57 
Comments 58 chapter Chapter 
-† key, crossref 59 -† 
Owner contains an Ele 
entry, e.g. afEle 

Local-Url 60 File Attachments 61 

Owner contains an Ele 
entry, e.g. afEle 62 

Bdsk-File-1, Bdsk-File-2 
etc. 63 

File Attachments 

URL, DOI 64 Bdsk-Url-1, Bdsk-Url-2 
etc. 65 

URL 66 

1.8.2. IMPORTING FROM B IBTEX  FILES  

References stored in the BibTEX format, can also be transferred back to your FileMaker data 
base LiteratureMY. Albeit, in contrast to the export technique described above no direct 
import is possible. You need EndNote as an intermediary step.  

An import is most conveniently accomplished by choosing in LiteratureMY the FileMaker 
script «Import from BibDesk» (Ctrl-7). All in BibDesk currently selected or shown records 
are then transferred via EndNote. Alternatively you can choose the BibDesk menu command 

 
suited to hold MyLiterature’s field Comments. If you enter data in both fields, i.e. BibTeX’s field note 
(EndNote’s Notes) as well as BibTeX’s annote (EndNote’s Research Notes), all data will be merged and end up 
in MyLiterature’s field Comments. 
56 Within BibDesk this field can be of a rather ephemeral nature and is normally also automatically converted 
into so-called Remote URLs, fields with a special treatment and which are named Bdsk-Url-1, Bdsk-Url-2 etc. 
57 Can hold multiple items 
58 In LiteratureMY field Comments typically stores such information. However, that field is exported to BibTEX 
field annote, since field Comments holds typically more information than just a chapter number. Thus, you need 
to extract chapter information manually, once the record is in BibDesk. Alternatively you can use a unique 
keyword to prefix the actual chapter information, e.g. CHAPTER. That can then be used – e.g. by an 
AppleScript – to extract and transfer the wanted information into BibTEX field chapter or note for systematic use 
in the list of references as generated by BibTEX. 
† not supported 
59 BibTEX field key must not be confounded with field cite key; the former can be used for alphabetical sorting, 
while the latter is used to cite. The BibTEX fields key and crossref should not be used. In particular crossref 
forecloses any conservative importing and exporting among the various data base systems used here. 
60 This field may hold a so-called file URL, e.g. “file://localhost/HD/Data%20Bases/pdf-collection/…”. Within 
BibDesk this field is of a rather ephemeral nature and is normally immediately converted into so-called Local 
Files, fields with a special treatment and which are named Bdsk-File-1, Bdsk-File-2 etc. 
61 EndNote can store several file attachments in this field 
62 Supplementary material is normally stored under the pdf name <SECode>_S.pdf. Thus it is possible to have a 
second pdf linked to a record. 
63 The BibDesk fields used to store links to pdf and other local, so called linked files. The data is not human 
readable, but can be accessed, e.g. through AppleScript, such, that it becomes readable, i.e. in the form of 
traditional Unix path. Enter a file in such a traditional form only as a local file URL via the field Local-Url. 
64 A maximum of 2 URLs can be stored in LiteratureMY (fields URL, DOI) 
65 The BibDesk fields used to hold any number of URLs, listed as so called Remote URLs and which are also 
shown in the right side pane as active thumbnails. 
66 EndNote can store several URLs in this field 
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"File -> Export -> EndNote XML…" The resulting file with extension "...xml" can then be 
imported into EndNote using the Import Option named EndNote Generated XML67. Once in 
EndNote the usual rules apply and you can use in LiteratureMY the FileMaker script «Import 
from EndNote (do entire transfer and quietly import file 'refs.out')» (Cmd-7).  

Note, all information hold by records in LiteratureMY is fully preserved in a transfer 
LiteratureMY -> BibDesk -> (EndNote) -> LiteratureMY. Some of those data are stored in a 
compact form in the non-standard BibTEX field custom5, which is also honored by the XML 
export to EndNote and which is unpacked by the AlphaX menu package “EndNote” to restore 
all as LiteratureMY needs (see also Appendix A2 «Transferring records (Overview)»). This 
means also while in BibDesk you should leave field custom5 untouched to ensure full 
preservation of all data when possibly transferring records back to LiteratureMY. 

 
67 The use of the utilities Bibutils (See Section «Conversion Utilities») is not recommended in this context, since 
they do not preserve sufficient information in such transfers. 
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1.9. Using BibDesk  

BibDesk68 is a great application that allows you not only to manage BibTEX files, but also to 
acquire records from ISI Web of Science and many other data bases such as NEBIS provided 
by the main library at ETH Zurich69. It is even possible to automatically assign a final main 
key (SECode, cite key) while acquiring new records within BibDesk. This is important, since 
BibDesk offers also to immediately link pdf’s to such newly acquired records and to store 
pfs’s conveniently in your pdf folder. All very powerful and very convenient in contrast to all 
other techniques offered by our system. Once acquired, the new records can be safely 
transferred to LiteratureMY for final storage.  

However, there are caveats associated with this technique, notably there is the risk of main 
key conflicts if both techniques of acquiring records should be used in parallel or in any other 
uncoordinated manner. However, if you adhere to a few rules such risks can be avoided and a 
smooth working flow can be achieved. These rules apply (details provided below): 

1) Customize BibDesk once to set its preferences to apply the same rules as employed 
by your LiteratureMY system. Following preferences need to be modified from the 
factory settings by making sure the hook AppleScript as contained in the BibDesk 
Support Work folder is installed for the respective hook similar as shown below: 
 

           
- VERY IMPORTANT: Automatic generation of proper Cite Key’s with two 

special hook AppleScripts Will_cite_key.scpt and Did_cite_key for the hooks 
(also called actions) Will Generate Cite Key and Did Generate Cite Key. 

 
68 A great open source application available from http://bibdesk.sourceforge.net/ 
69 Requires the installation of a little BibDesk Search file (extension ‘.bdsksearch’). Many data base services 
offer now such search files. One for NEBIS, named ‘NEBIS-zoom.bdsksearch’, is also distributed with the 
package EndNote SE Add Ons… (disk image EndNote SE Add Ons….dgm). You need to install it only once in 
BibDesk (menu Searches) and should then be able to conveniently search in NEBIS from within BibDesk. 
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- Automatic conversion of local file names, i.e. typically PDFs, and automatic 
filing by BibDesk with the hook AppleScript Did_autofile.scpt for hook (also 
called action) Did Auto File. 

- Similarly when importing records, e.g. from FileMaker data base 
LiteratureMY, install AppleScript Fix PDF and URL Links.scpt for hook (also 
called action) Import Publications. 

2) Install some utilities, notably AppleScripts such as DumpCodesMY, that allow to 
conveniently coordinate your work between BibDesk and LiteratureMY. The latest 
version of hook AppleScripts Will_cite_key.scpt and Did_cite_key do 
automatically keep track of the current situation. They invite you to run 
DumpCodesMY whenever needed and it is highly recommended to follow any such 
invitations. 

Once properly setup you need to stick to following rules of usage: 

1) Either acquire new records in BibDesk or LiteratureMY, but never do so in both at 
the very same time. 

2) When starting to use BibDesk to acquire records run utility DumpCodesMY 
whenever invited to do so. The latest main keys as assigned by LiteratureMY will be 
made available to BibDesk 70. 

3) Always before you resume using LiteratureMY to acquire new records transfer all 
the records you have acquired in BibDesk back to LiteratureMY. This will ensure 
CodesMY is properly updated and LiteratureMY learns about the main keys you 
assigned in BibDesk. 

1.9.1 CUSTOMIZING B IBDESK  

You need several files extending the default capabilities of BibDesk and to set BibDesk’s 
preferences accordingly. All necessary scripts and template files are distributed within a 
folder BibDesk Support71 that comes with the ordinary distribution of the LiteratureMY 
system (FISCHLIN & NEMECEK, 2001). Copy the folder BibDesk Support  

 
70 BibDesk uses actually a small text file, say CodesBibDeskAF (initials at end vary from user to user), to store 
similar information as CodesMY does. Make sure you well preserve this file. To coordinate the main key 
assignment, an additional auxiliary file will be generated by AppleScript DumpCodesMY named e.g. 
DumpOfCodesAF. BibDesk will make sure that correct keys are assigned if DumpOfCodesAF’s content is 
uptodate and properly reflects the content of CodesMY. 
71 This folder resides within the folder named similar to Lit SE Aux Files 3.5r3 and is anyway to be copied to 
your hard disk when working with LiteratureMY (see also FISCHLIN & NEMECEK, 2001). 
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to your system to a permanent location. This folder also contains an installation script 
SE_BD_Installer.command72 that you need to run73 for preparing the customization of 
BibDesk. It will install symbolic links as needed and make the following one time 
customization74 of BibDesk easy. For further installation details and hints consult also the 
provided ReadMe file. 

The following describes the needed one time customization of BibDesk step by step75: 

Very crucial is to always generate only proper cite keys. Note, the main key (SECode, 
SysEcolCode) or Cite Key needs to be globally unique. This is accomplished by using the 
provided script that can generate a globally unique cite key while acquiring records. BibDesk 
supports the automatic generation of such a main key, but requires additionally following 
customization so that BibDesk’s behavior fully conforms to the rules of the LiteratureMY 
system. 

 
72 Double-click the script and follow instructions 
73 To be on the safe side, run this script after each update of the folder BibDesk Support although a mere 
recopying of folder BibDesk Support to your hard disk may already suffice 
74 The customization needs to be done only once and updates typically require to recopy folder BibDesk Support 
to your hard disk and perhaps also to rerun SE_BD_Installer.command 
75 You can spare yourself this rather time-consuming customization by simply unarchiving in folder BibDesk 
Support the zip file edu.ucsd.cs.mmccrack.bibdesk.plist.zip and copy the resulting file 
edu.ucsd.cs.mmccrack.bibdesk.plist to folder ~/Library/Preferences. However, you may nevertheless need to 
read the explanations of the recommended settings, notably when you prefer to deviate from the here 
recommended preference settings. 
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1.9.1.1 Setting preferences and other installations 
1) Set your Cite Key preferences in BibDesk similar to this:   

  
 where you need to set the last characters, here ‘dg’, according to your MY 76 (or none 

in case MY is ‘af’). 
2) Set your Script Hook preferences Did Generate Cite Key in BibDesk similar to this 
(select hook and click + and see table below for the actual files to choose):  

 
 Similary set the Will Generate Cite Key hook preference to use the script 

Will_cite_Key.scpt. Now any cite key generation will follow the LiteratureMY rules. 

 
76The Format String specifies that the main key is to be constructed from the first 2 characters from the first 
author (%a12) followed by a unique number consisting of 3 digits (%n3) and the MY characters. The example 
shown here is for MY being ‘DG’ (Dimitrios Gyalistras; if MY is ‘AF’ the format string becomes %a12%n3).  
 
Note, in case of author names with so-called von parts such as ‘van der Pool’, BibTEX considers the last name to 
be only the first capitalized word. Thus, to follow the LiteratureMY cite key rules, a first author such as ‘van der 
Pool’ should be written as ‘Van der Pool’ to make the last name start with “Va” (Kopka & Daly, 2004, p. 235).  
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3) Set the remaining Script Hooks (see previous step): In general BibDesk’s Script 
Hooks are best specified as follows: 
 

Hook AppleScript 
Did Auto File Did_autofile.scpt (or Cleanup PDF Repository 77) 
Will Generate Cite Key Will_cite_key.scpt 
Did Generate Cite Key Did_cite_key.scpt 
Import Publications Fix PDF and URL Links.scpt78 

 This customization step connects a particular BibDesk event, called a hook, with a 
particular AppleScript or Action that is automatically executed whenever BibDesk 
encounters the hook event. Note, this step requires that you have previously copied 
folder BibDesk Support to your system and successfully run the installation script as 
described above. To specify a hook select the event, say Did Auto File (as shown 
above), and click on the  button. BibDesk then opens by default folder 
~/Library/Application Support/BibDesk. There in subfolder Scripts79 you find most 
of the needed scripts and your file selection dialog may look similar to this: 
 

 
  

 Choose the corresponding AppleScript and you are done.  
 
Note, hook scripts such as the crucial Did_cite_key for the event Did Generate Cite 
Key reside not in the regular script folder (shown above) as offered by BibDesk. Find 
it in your folder BibDesk Support/Scripts/Hooks. For all other scripts you should find 
a symbolic link in the regular BibDesk script folder. 

 
77 This is actually the very same script named differently. Cleanup PDF Repository is merely a symbolic link to 
the actual AppleScript Did_autofile.scpt. Note, this script is overloaded and has three distinct, context dependent 
functions: (i) BibDesk hook (here specified), (ii) Folder Action and (iii) cleanup utility for your PDF Repository 
folder offered in BibDesk’s AppleScript menu. Using different names for the symbolic link and the hook is 
useful and describes the actual purpose and function of the script depending on context and effective function. 
78 This script may become very slow when importing thousands of records. Disable this hook in such cases and 
run the script manually piecewise for a max of roughly thousand records at a time. 
79 i.e. ~/Library/Application Support/BibDesk/Scripts 
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Why? Note, all scripts residing in folder ~/Library/Application Support/BibDesk/Scripts 
are also available from within BibDesk in its AppleScript menu . Since you must not 
run hook script Did_cite_key from within BibDesk – it would assign a new cite key 
without warning – you should leave its execution only to the event Did Generate Cite Key. 
To avoid such risks, the installer script intentionally creates no symbolic link to hook 
scripts Will_cite_key.scpt nor Did_cite_key.scpt in folder ~/Library/Application 
Support/BibDesk/Scripts. 

 

 Finally I recommend to install also script Did_autofile.scpt as a Folder Action 
script80 for your pdf repository folder. This should allow you to drag and drop pdf’s 
to your repository folder and the files are automatically stowed away into the 
subfolders starting with the same letter as the first author.81 Don’t worry, recent 
versions of BibDesk can keep track of renaming or moving files around, in case that 
file should already have been linked to a record in BibDesk. Having the BibDesk 
hook Did Auto File as well as a Folder Action active at the same time may 
occasionally cause incomplete stowing away of pdf’s.82 Note, in such cases you can 
always as a last resort manually execute the script Did_autofile.scpt anytime: Simply 
run the script from within BibDesk by choosing menu command Cleanup PDF 
Repository83 from BibDesk’s AppleScript menu. 

4) Choose menu command Dump CodesMY from BibDesk’s AppleScript menu. Upon 
successful completion you should have file DumpOfCodesMY84 in your literature 
work folder85. 

 Now you should be ready to acquire new records from within BibDesk and BibDesk 
will assign automatically a proper main key (SECode or cite key) anytime you 
import new records (see also below, Section «Using BibDesk - a short tutorial»). 
Note, this technique offers not only the advantage of generating conveniently a main 
key unique within the current BibDesk file, but also across several BibDesk files, 
may they be currently open or not. This extends the normal BibDesk capabilities of 
generating cite keys considerably, since by default cite keys are only unique within 
the same BibTEX file. Moreover, this technique avoids also conflicts with the keys 
already used by the LiteratureMY system. However, be warned, please adhere to the 
usage rules as described above in the yellow box. 

 
80 This script was previously also called pdfwar - Store In Letter Folder. The latter is still made available in the 
release, but is obsoleted by the new, more versatile Did_autofile.scpt. I recommend to use only the new hook 
sript as the Action Folder for your pdf repository folder. 
81 As of this writing, 26.Sep.2009, script Did_autofile.scpt does log its activities. You can easily inspect this log 
by launching application Console from your folder /Applications/Utilities and view the log file BibDesk.log or 
by double clicking file ~/Library/Logs/BibDesk.log. 
82 Note, this implies, if you use script Did_autofile.scpt as a Folder Action for your repository folder, that this 
may interfere with the hook Did Auto File also calling script Did_autofile.scpt. However, this may depend on 
actual speed of your system and other real time issues. Try it out and adjust your configuration accordingly! 
83 This menu command actually executes script Did_autofile.scpt (symbolic link in BibDesk’s scripts folder to 
file Did_autofile.scpt) 
84 MY will actually be translated to your initials as defined by shell variable LITUSER, e.g. DumpOfCodesAF. 
The value of LITUSER is assigned automatically as sourced from file ~/bin/LITMYPath.txt (provided with 
distribution of package EndNote SE Add Ons…). 
85 as defined by shell variable LITMY, e.g “/Volumes/HD/uaf/Data Bases/AFs Lit” (may contain blanks). The 
value of LITUSER is assigned automatically as sourced from file ~/bin/LITMYPath.txt (provided with 
distribution of package EndNote SE Add Ons…). 
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Be warned: If you violate any of above rules (see yellow box) you risk that 
incorrect main keys are assigned while adding new records! 

 

5) Set your AutoFile preferences in BibDesk similar to this:   

 
 

 where the folder in which you keep your pdf’s – the pdf repository folder – needs to 
be specified once using button  Choose….  

 You have also to use the button to enter the Format String for local files 
similar to this: 

 
 
 Any pdf you drag and drop onto BibDesk’s side pane to the right will then be linked 

to the record, automatically renamed according to the rules, and is even conveniently 
moved to the specified pdf repository folder. Moreover opening pdf’s is then not 
only possible from within BibDesk, but also from within EndNote as well as 
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LiteratureMY.86 The renaming and moving of pdf’s (BibDesk calls this feature 
AutoFile) happens automatically if you check the preference “File papers 
automatically”  (recommended87). Having this preference off may 
also be an option, since you can autofile pdf’s for some selected publications later 
anytime by choosing within BibDesk the menu command “Publication -> AutoFile 
Linked Files…”. Experiment and choose this preference to your taste. 

 Alternatively, e.g. if you wish to create a self-contained folder holding the BibTEX 
file along the pdf repository, then it is also possible to define the preferences as 
follows: 

 
 Note that the relative path to the actual pdf repository has to be entered as a prefix to 

the ‘Format String’. In above example the relative path denotes the folder 
‘Bibliography’ that resides beside the BibTEX file ‘MyBibTeXFile.bib’. Here the 
Finder view for above example: 

 
 With such settings you may move folder ‘BibDesk work’ freely. However note, each 

move typically requires to adjust also the content of file ‘~/bin/LITMYPath.txt’ 

 
86 It may be preferable to specify the same shortcut for opening pdf’s in all applications as EndNote provides, 
i.e. Command-Option-P by defining this very same keyboard shortcut in the System Preferences pane Keyboard 
& Mouse for FileMaker as well as BibDesk. 
87 The reason is that you may link to pdf’s stored in temporary directories that get occasionally cleared, e.g. for 
sure during a system restart. Thus it is generally safer to immediately move pdf’s to where they should be. 
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accordingly to ensure all BibDesk AppleScripts work normally and without 
warnings. 

6) Set your Default Fields (= Fields) preferences in BibDesk to this:  

 
 I highly recommend to at least check field Doi for optimal cooperation between 

BibDesk and LiteratureMY, but you may wish to customize Fields further once you 
learned better how to use BibDesk. 

 To fully support the reference type Map, you should also define the non-standard 
BibTEX field Cartographer as being of type Person. Click on the  button and enter 
following specifications: 

 
 Then make also sure BibTEX fields Pages and Note are available for all reference 

types. If necessary click on the  button and enter specifications as shown here: 

 
 Finally the fields of the reference types proceedings and inproceedings defaults are 

insufficient for our system. Click in section ‘Advanced’ on button ‘Edit…’ 
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 and add for type proceedings the fields type, series88, pages, and optionally custom5à 

(not shown) under Optional Fields: 

 
 similarly add for inproceedings field type and optionally field custom5à (shown): 

 
 similarly I recommend to add for reference type webpage fields Author, Title, 

Publisher, and Type: 

 
88 Series is the field to hold LiteratureMY field SeriesTitle.  
à Note that for LiteratureMY field SeriesEditor exists no corresponding BibTEX field and the information is 
stored in field custom5 together with other field data that do not fit into the BibTEX scheme (cf. Section «Expor-
ting to BibTEX files»). Yet, you can enter in BibDesk series editors by entering into field custom5 the series 
editor(s) between this prefix ‘REFTYPE OWNERS USERS REFSTATUS ENTRYDATE MODIFIED TH C6 
C7 SE‘ and this suffix ‘MF’. Ex. For series editor Felix Smith you would enter into field custom5: ‘REFTYPE 
OWNERS USERS REFSTATUS ENTRYDATE MODIFIED TH C6 C7 SE Smith, Felix MF’. However it may 
be more convenient to enter that information using FileMaker once the record has been transferred to 
LiteratureMY (field labelled ‘SeriesEds.’). Thus add field custom5 or not according to your data entry 
preference. 
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 I highly recommend to automatically convert added files and URLs, i.e. to have 

preference “Automatically convert File and URL fields” checked. This means that 
pdf’s and URLs are shown in the right side pane as active thumbnails upon entering 
BibDesk , e.g. as a result from a transfer from LiteratureMY to BibDesk or other 
means of importing records. Set the checkboxes to your linking. The first checkbbos 
keeps or removes upon conversion the field Local-Url. That is always used during 
imports and denotes the attached pdf. Once imported there remains little use for that 
field. On the other hand, if working with Mendeley then that checkbox should 
remain unchecked to support automatic pdf attachment during imports. Concerning 
checkbox “Remove converted Remote URL fields”, I personally prefer to keep the 
old-fashioned fields Url and Doi intact. If you check it, any possibly present field 
Url and Doi will also be emptied (Doi89) and/or removed as redundant from the 
record (Url). More can also be learned in the next Section «Using BibDesk - a short 
tutorial». 

7) Set your Opening and Saving (= Files) preferences in BibDesk to this:  

 
 I recommend to use above settings to ensure all special symbols are properly 

transferred among all systems always. Abstracts containing texts such as “…no more 
than 2°C.” can then be read without any trouble in BibDesk, EndNote and 

 
89 The field Doi is shown as present, yet empty, if it has been checked to be present by default as shown above 



Latest Additions Literature November 12, 2024 

46 

LiteratureMY. However, if you write a paper with LaTEX, then other preferences are 
preferable and you may need to check the Unicode to TeX Conversion. 
  Writing with LaTEX requires Unicode to TeX Conversion saved BibTEX-
files, i.e. preference Convert accented characters to TeX when exporting or pasting 
BibTeX needs to be checked. Fortunately, BibDesk can do the Unicode to TeX 
Conversion on the fly. Merely save your bibliography after having checked the 
preference Convert accented characters to TeX when exporting or pasting BibTeX 
and then, once saved, you are free to uncheck that option again according to the here 
recommended preferences. It is therefore recommended to do this save to another 
read-only BibTEX-file, the one actually used by LaTeX, which typically resides in 
the same folder as your master TeX-file and keep the master BibDesk file where you 
manage the references not only separate, but store it always with above 
recommended settings. 
  Standard TeX coding of special characters such as Umlaute is sometimes 
ugly to read in BibDesk (unless exactly the same formatting is used; e.g. ‘ü’ can be 
correctly coded in LaTeX as ‘\”{u}’ or ‘{\"u}’; BibDesk handles only the latter 
format correctly90). It is therefore preferable to have always option Unicode to TeX 
Conversion unchecked and to save all BibTEX-files with UTF-8 encoding except for 
the read-only BibTEX-files actually actually used by LaTEX(see above). 
  Conversions between encodings are tricky. Since there may still arise the 
need to use other encodings than the above shown ones91, in partiuclar also the 
traditional ‘Western (Mac OS Roman)’ encoding for the Macintosh platform, read 
footnote 92 for important hints on handling such situations. Moreover, our data base 
system offers many utilities and scripts supporting conversions, in particular when 
compatibility issues arise93 (see also section 2.5 «Conversion utilities»). 

 
90 This means that not all legal BibTEX syntax, as e.g. obtained from a web site offering a BibTEX citation export 
service, can be properly handled by BibDesk. The utility deTeXforBD.sh (part of distribution of package 
EndNote SE Add Ons…) helps you by converting all legal BibTEX syntax to a common encoding, e.g. UTF-8, 
that BibDesk can actually handle. 
91 As of this writing all components of the here described data base system (26.May.2016, version 3.7r16 
including AlphaX’ EndNote Menu v2.2 and later) support now fully UTF-8 encoding throughout. Since 
considerably more powerful than ‘Western (Mac OS Roman)’, UTF-8 is therefore now the recommended default 
encoding (see above figure Opening and Saving (= Files) preferences). Note however, on the Mac platform, only 
the traditional ‘Western (Mac OS Roman)’ encoding offers still maximal compatibility with other programs such 
as Excel, which cannot import UTF-8 as of this writing (2.Feb.2016) or AlphaX v8.2.3, which does not show 
UTF-8 encoding in a readable manner. In such cases you may therefore wish or need to go back to ‘Western 
(Mac OS Roman)’ encoding.  
92 Note that BibDesk cannot change the encoding during the opening of a BibTEX-file (bib-file). Say a file is 
stored in ‘Western (Mac OS Roman)’ and you set the ‘Opening and Saving’ preference here to encoding UTF-8, 
BibDesk throws a warning message during an open attempt (as of this writing Version 1.6.5 (3713), 2.Feb.2016). 
To lose no information it is in such a case best to stick always to the original file encoding during the opening of 
BibTEX-files, i.e. click button ‘Reopen’ (and not ‘Ignore’). You can nevertheless use BibDesk to change 
conveniently the encoding, say from ‘Western (Mac OS Roman)’ to UTF-8: Simply open the BibTEX-file in the 
original encoding and then export its content to a new file (menu command “File -> Export…”) in the new 
wanted encoding. Alternatively, thanks to the fact that BibTEX-files are simple text files, you can also use 
commando line tools such as utility ‘mac2utf8’ or ‘iconv’ to convert encodings of BibTEX-files. 
93 Notably see utility utf82mac for details and the BibDesk AppleScripts Fix-Paste Abstract.scpt and Fix DOI 
and Case In Title, Author.scpt, which can deal with many situations, notably also with difficult mixed encodings 
as one encounters today frequently with citation exports, where often messy and mixed encodings result or even 
basic syntax, e.g. of BibTEX, is violated. These scripts perform elegantly and robustly multiple conversions in a 
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 Optionally you can also customize BibDesk  to support EndNote  citations: 

8) (optional, recommended) Set your Template Files (= Templates) preferences to this: 

 
 while using the template files CiteEndNoteTemplate.txt and SE_Style.txt (actually 

symbolic links as installed by SE_BD_Installer.command) from folder 
‘~/Library/Application Support/BibDesk/Templates/’. As a result you may choose 
menu command "Edit -> Copy As" with the template EndNote Citation to get 
exactly an EndNote conformant temporary citation in your clipboard, which you can 
paste e.g. into a Microsoft Word document. The standard Services menu may also 
provide easy access to such a clipboard in applications that support Services.  

 Choosing menu command "Edit -> Copy As" with template SE Style will give you in 
the clipboard a full reference as used in a list of references. For really convenient use 
of this template I have defined keyboard shortcut Ctrl-K (in analogy to EndNote’s 
Cmd-K) for SE Style. Do this in the System Preferences pane Keyboard & Mouse for 
BibDesk (see below), following the technique as described in Section «New helper 
scripts». 

9) (optional) Set your Citation Behavior (= Citation) preferences similar to this:  

 
 As a result you may now even drag and drop from BibDesk to Word to get an 

EndNote conformant temporary citation or get it via clipboard by choosing standard 
menu command “Edit -> Copy” (Cmd-C). All very convenient! 

 
series that produce in the end a consistent encoding throughout as actually required by the current BibDesk 
preferences. 
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10) (optional, recommended) Extend your Template Files preferences in BibDesk 
further to support extraction of bibliographies using the AppleScripts Extract 
Bibliography and Extract For e-Reading:  

 
 If you install a template named SE HTML Bibliography as shown above you enable 

following: First, you can choose menu command "Edit -> Copy As -> Template -> 
SE HTML Bibliography" and you will have in the clipboard the html code for an 
entire web page that lists all currently selected publications. Secondly, you can run 
AppleScripts Extract Bibliography and Extract For e-Reading. Extract Bibliography 
will generate an entire folder that contains not only a web page (index.html) listing 
all currently selected publications, but will also copy all original pdf’s linked to 
those publications. The links in the web page allow to read the copied pdf’s outside 
and independently from BibDesk. This supports the extraction of entire bibliogra-
phies, e.g. the publishing of a project specific bibliography on the internet or for ar-
chiving purposes. AppleScript Extract For e-Reading behaves similarly, however it 
creates not a separate folder but updates incrementally the so-called ‘e-Reading fol-
der’ by a html page and the corresponding pdf’s. The ‘e-Reading folder’ is thought 
to be synced via a cloud service such as Dropbox with an e-Reader, e.g. an iPad. 

 Note, AppleScript Extract Bibliography serves the same purpose as utility MakeFileIndex. 
Similar to MakeFileIndex you can control certain elements of the resulting web page by 
specifying flags or strings in the same data frame file94 that you can use to control the 
behavior of utility MakeFileIndex. As of this writing the following parameters are supported 
by SE HTML Bibliography installed to call the post processing shell script 
SEHtmlExportPostProcessing.sh: 

 
94 This file is called MakeFileIndex.DTF and is also distributed as part of BibDesk Support (subfolder 
Templates). Move MakeFileIndex.DTF to your pdf repository folder and edit it to your liking before using 
AppleScript Extract Bibliography (note, however, the post processing shell script works independently from 
BibDesk and will therefore retrieve the pdf repoistory folder location only from file ~/bin/LITMYPath.txt, not 
from BibDesk’s preference settings). For instance MakeFileIndex.DTF allows you to specify the heading (value 
definition for string TitleAddon) for your web page bibliography as contained in the generated file index.html. 
Note, if file MakeFileIndex.DTF is not present, you won’t be warned and default assumptions are made. 
Moreover, note, the CSS file SEHtmlExportStyleSheet.css allows full control over the appearance of the web 
page as generated by AppleScript Extract Bibliography, even after its generation. However, note, upon each 
extraction a new copy from the original CSS file residing within folder BibDesk Support will be made and the 
CSS file residing in the destination folder will be overwritten upon each script execution. Edit either the original 
or edit the copy only once all is perfectly extracted. 
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• PDFsInNewWindow (flag causing pdf’s opening in separate window) 
• FileListFile (name of index file) 
• TitleAddon (text fragment used in web page title) 

11) (optional, recommended) For previewing publications in BibDesk’s main window at 
the bottom, it is highly recommended to extend your Template Files preferences in 
BibDesk further by adding following templates: 

  
 

 
 Notably the Two Columns RTFD template is highly recommended to use for 

previewing publications at the bottom of the BibDesk window. To activate that 
template choose in BibDesk menu command "View -> Bottom Preview -> Two 
Columns RTFD template". Similarly you can of course choose for bottom 
previewing any of the other templates, including the ones preinstalled, as you like. 

 Find further details on templates, notably how to construct your own at   
 
       https://sourceforge.net/p/bibdesk/wiki/Templates/  

 

12) (optional) Extend your Template Files preferences in BibDesk further to support 
extraction of publications for the generation of a website. These templates are not 
used in any BibDesk AppleScripts. Use them by choosing in BibDesk menu 
command "Edit -> Copy As -> Template -> SE Publications" and you will have in 
the clipboard the html code for an entire web page that lists all currently selected 

https://sourceforge.net/p/bibdesk/wiki/Templates/
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publications. For this to work you need to install following set of Template items 
called SE Publications in BibDesk’s preferences: 

 
13) (optional) install the capability to search in the NEBIS system of the ETH Zurich 

library. As of this writing this Z39.50 query standard based service is unfortunately 
no longer available. The following instructions are nevertheless kept in this 
document as the described procedure may be helpful for installing other custom 
Searches in BibDesk.  
 The goal of this installation is to have in the Searches menu a new permanent search group NEBIS available 

similar to this: 

 
 The distribution BibDesk Support contains a folder Searches that contains the needed file NEBIS-

zoom.bdsksearch. Drop95 the .bdsksearch-file on the left Groups pane of any currently open BibDesk 
window. Then make that new search group permanent by selecting it and choose menu command “Searches -
> Add Search Bookmark…”  

 

 
95 Alternatively simply double-click the .bdsksearch-file and you will get a new search group in the Groups pane 
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 Note, in newer BibDesk versions the newly created search group may be named NEBIS and not merely 
Empty96. Before clicking OK97 for permanent adding rename the search group for easier recognition similar to 
this 

 
 Finally edit the appearance to your liking for instance by inserting separators or edit any time other properties 

by using menu command “Searches -> Edit Search Bookmarks”. You can now easily search in NEBIS 
anytime by choosing the menu command “Searches -> NEBIS”. 

 Further instructions on search groups can be found at:   
 
       https://sourceforge.net/p/bibdesk/wiki/BibDesk_Search_Groups/  

1.9.1.2 Recommended shortcuts 

Here a possible set of keyboard shortcuts98 to be used with BibDesk:  

 

Note that two keyboard shortcuts are defined for each AppleScript command for which we 
define a shortcut. The first is the ordinary one, whereas the second command is prefixed by 
the phrase “Show “ and uses as modifier the option key ⌥. This overcomes a bug in Mac OS 
X99, to avoid having for each AppleScript menu with a shortcut command two menu items 
present at all times, regardless whether you press the option key ⌥ or not. ‡ 

 
96 See that the search field shows the involved search service, i.e. greyed out text Search NEBIS. Note, the 
bottom of the window, the so-called status bar, shows similar information for the currently selected search 
group. If not visible choose menu command “View -> Show Status Bar”. 
97 Older BibDesk versions, e.g. 1.4 (1758), offered only Bookmarks Menu as Add to choice. This was confusing. 
In case, ignore this, since the search group will actually be added to menu Searches and not Bookmarks. 
98 All recommended shortcuts can be easily installed by double-clicking the script Install-FM-hotkeys.command 
99 Present in Mac OS X 10.5.8 (Leopard) and Mac OS X 10.6.3 (Snow Leopard) 
‡ BibDesk’s AppleScript menu offers the possibility to edit any installed AppleScript by using the Option key ⌥ 
as modifier: Then every menu command turns into a “Show <command>”. If you choose such a “Show 

https://sourceforge.net/p/bibdesk/wiki/BibDesk_Search_Groups/
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The result of above customization results in following AppleScript menu (note, the actual 
menu may deviate from the one shown here, see below for most recent version): 

 

To make good use of the provided AppleScripts read their explanations after having opened 
them in the Script Editor.‡ Some of these scripts can also be easily customized by changing 
their property values that serve as preferences. The provided comment texts explain their use. 

The above described customization of keyboard shortcuts changed other BibDesk menus as 
follows: 

 
 

 
<command>”, the corresponding AppleScript will be opened in the AppleScript editor (Script Editor or 
AppleScript Editor). Note I know of no technique to hide the extra “Show …” command if you use a 
combination shortcut involving also the ⌥-key such as Command-Option-R. Thus I try to use as much as 
possible only Control-<key> (^ <key>) shortcuts. 
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In addition to the keyboard shortcuts described above, I use also the following shortcut for 
BibDesk overriding BibDesk’s default Command-Shift-K, which avoids conflicts with other 
system-wide shortcuts I have in use (I reserve Command-Shift-<key> for jumping to folders): 
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The most recent script collection installed by default100 plus some personal AppleScripts and 
applying my shortcut customization gives an AppleScript menu that looks similar to this: 

 

Note, the superfluous entries ‘Show “Extract For e-Reading”’, ‘Show “Select e-Reading Publications”’, and 
‘Show “Sync Back From e-Reading”’ are not intended and spuriously generated by the operating system (see 
footnote‡). Unfortunately I know of no technique to circumvent the display of those unwanted menu commands, 
except to use a shortcut that does not involve the Option key ⌥ as a modifier, e.g. Ctrl-R or Ctrl-B. But I like my 
shortcuts, since the modifiers as shown here are the same as those I use for the related commands that open or 
reveal pdf’s in the three applications FileMaker, EndNote, and BibDesk, meaning I can use in all applications the 
very same shortcuts for the same purpose. 

 

In case of difficulties with BibDesk’s configuration consult also Appendix A7 
«Troubleshooting hints». 

 

 
100 i.e. running installation script SE_BD_Installer.command 
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1.9.2 USING B IBDESK  -  A SHORT TUTORIAL  

Once customized as described in previous section try it out. Launch LiteratureMY, select 
some records and choose FileMaker script «Export to BibDesk». BibDesk is launched and 
your records should appear in a new window. In case BibDesk was already running and had 
some bib-file open, the records will be imported and are shown highlighted within the 
frontmost window similar to this: 

 

Secondly try to acquire some references from ISI Web of Science by choosing menu 
command “Searches -> Web of Science SCI”: 
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Then type  

AU=Fischlin AND TI=forest? 

into the appearing search field and press return you should get something similar to this: 

 

Queries of ISI Web of Science can be any boolean expression using these field tags101: 

   or NEBIS, a Z39.50 service, uses these tags:   

Ex.: ISI WOS: ((ts="larch bud moth" OR ts="larch budmoth" OR ts="Zeiraphera diniana") AND 
(py=2000-2008)) OR ((au=Nemecek T*) AND (py=1995 OR py=1996)). NEBIS: au=”Fischlin, Margrit”. 
PubMed: “Fischlin A” [AU] AND (gap [ALL] OR forest* [TIAB]) (see also Appendix A12). 

Note I have customized the columns display by using the popup menu at the right corner and 
inserting the field Doi (using Add Other…) into the default display and having rearranged the 
order as shown here. This offers the advantage that you can immediately jump to a paper via 

 
101 Further details on how to encode such searches can be found in BibDesk’s help system (topic «Searching 
External Databases») and at http://images.isiknowledge.com/WOK46/help/WOS/h_advanced_fieldtags.html  

http://images.isiknowledge.com/WOK46/help/WOS/h_advanced_fieldtags.html
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its DOI. Try it out and you should get something similar to this: 

 

You may decide you are not really interested in the FUHRER et al. (2006) paper but wish to 
keep FISCHLIN & GYALISTRAS (1997) (assuming this record is really missing in your 
LiteratureMY102). Accomplish the import by clicking onto the little import button in the 
leftmost column, i.e. . Then leave the searching in ISI WOS Group and go back to the 
group Library by clicking on the yellow BibDesk icon at the top. The result should look 
similar to this: 

 

 
102 Running in BibDesk’s script menu  the AppleScript “Show In LiteratureMY” (Ctrl-H) tells you that. 
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Note, a new main key (cite key) has automatically been assigned103 and the red cite-key 
symbol , which indicated a missing main key, is gone. You can now also access the ISI 
WOS web site clicking onto the top right thumbnail in the pane to the right side of the 
window and using there the button  

 

It gets you to the JSTOR repository of the paper  

 

 
103 You may easily create a new main key by simply choosing menu command “Publication -> Generate Cite 
Key” (Cmd-K). However, you should refrain from wasting codes and refrain from using this command unless 
this becomes a necessity to avoid conflicting cite keys. 
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where you can download the pdf. You could download it to any location on your disk, but I 
recommend to open it in Adobe Reader by a control click104, once the pdf shows up in the 
browser window. The advantage of having it opened in Adobe Reader is that you can simply 
drag and drop the pdf from the title bar of the Reader’s window to the right side pane of 
BibDesk (next figure, left). This should immediately link the pdf with your record, rename it 
and move it to the proper location on your disk (assuming you have set the preferences as 
described above) and a corresponding thumbnail for the pdf should appear in the right side 
pane of your BibDesk  document window (next figure, right).  

                     

You are now done if your preference settings “File papers automatically” is checked, because 
the pdf was renamed to ‘Fi160.pdf” and filed to the wanted location where you keep your 
pdf’s. Otherwise choose menu command “Publication -> AutoFile Linked Files…” (Cmd-
Shift-K) and the file is also renamed and permanently stored at the wanted location. 
BibDesk’s window looks now similar to this: 

 

 
104 This convenient method is NOT available if you have not prevented the intrusive Adobe Reader plug-in be 
used in your browsers. I recommend to always turn this feature off, by setting the internet preferences in Adobe 
Reader (or Acrobat) such that check box “Display PDF in browser using: Adobe …” is not checked. Then a 
browser such as safari uses the internal Mac OS X capabilities to display pdf’s, which is more efficient and more 
convenient than Adobe’s plug-ins. 
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There is an alternative, very efficient technique available to link pdf’s to a record, which is 
most attractive if your record has a DOI. For this to work I recommend to use the free Camino 
browser as the default browser for BibDesk. To accomplish this simply run the AppleScript 
command Use Camino105 once. Then set the download preferences in the Camino browser as 
this106: 

 

From now on it becomes easy to link pdf’s to a record: (i) double click the DOI; (ii) open the 
pdf on the web site; (iii) once the pdf is opened in Adobe Reader, switch back to BibDesk and 
execute the script “Link PDF from Adobe Reader”107 and you are done. 

Let’s do something more technical within BibDesk, i.e. editing the record. First you may wish 
to add some comments. Hit return or double-click the record to open it for editing. See, the 
standard BibTEX  field note is missing. Add it by clicking onto the + in the lower left corner 
and enter the field’s name similar to this: 

 

 
105 If you followed the recommended installation procedure as described in Section «Customizing BibDesk», 
notably having run installation script SE_BD_Installer.command, all needed AppleScript scripts were installed 
in BibDesk’s AppleScript menu. In this context useful keyboard shortcuts are suggested in Section 
«Recommended shortcuts». 
106 Folder /tmp is recommended to avoid scatter with downloads that serve only temporal use as an alternative to 
the default Downloads folder. The /tmp folder is normally not visible in the Finder, but you need it to become 
visible to configure Camino as recommended. There are two simple techniques to open the /tmp folder: In the 
Terminal application enter command “open /tmp” or use Finder’s menu command “Go -> Go to Folder…“ and 
enter “/tmp”. Once open, you can easily choose it when you have Default Folder in use. Without Default Folder 
I recommend to create a permanent alias to the /tmp folder, e.g. in the Downloads Folder, which then can be 
used in the configuration dialog of Camino anytime. 
107 In case you have PDFKey Pro (http://www.pdfkey.com) on your system and have its command line tools 
installed as well, the script “Link PDF from Adobe Reader” will even attempt to unlock the pdf on the fly. 
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And then enter your comments 

 

While we are at it, let’s also copy the stable URL provided by JSTOR into the new record, 
since that URL can not directly be dragged and dropped from the browser to BibDesk’s right 
side pane. We can create another new field, i.e. field Url for that in the same manner we have 
created the standard BibTEX  field note. Then copy-paste the data from JSTOR’s web site to 
your record: 

 

Save your data by choosing command “File -> Save” (Cmd-S). Notice the little symbol to the 
right of the new field Url?  

 

It allows you to conveniently jump to this URL. We are done and can close the editing 
window.  

However, the nifty jump button was available only while editing the record! Of course we 
could add the column Url to the standard list view as we have done for the DOI in order to be 
able to jump to the just added URL. However, there is a better technique available and the 
field Url should be used as little as possible: Choose menu command “Data base -> Convert 
File and URL Fields” and click on button Convert 
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This will let appear the added URL magically in form of an additional thumbnail on the right side 
pane, which should now look similar to this  

 

This conversion makes the just added URL available for jumping. This conversion is therefore always 
recommended, in particular before transferring records back to LiteratureMY. Note, if you forget to 
convert, you may risk losing some information, perhaps even links to your pdf’s.108 

Finally, lets transfer the just acquired record back to LiteratureMY. How to find newly 
acquired records in a large bibliography? Simply type “fromBibDesk” into the search field 
you find at the top right corner of BibDesk ’s window 

 

and all records that were acquired from within BibDesk are shown. Note, each time you 
generate a new cite key for a record, the phrase “fromBibDesk” is added to a special field 
Custom2:  

 
108 Note, with the recommended settings (see previous Section «Customizing BibDesk ») this conversion will 
also convert and remove any so-called file URLs (starting with file://localhost…) stored in a field Local-Url and 
make them also appear on the right side pane. Such local file URLs may have resulted from importing records. 
However note, this is a one-way avenue, since the exporting of the content of the fields Local-Url (as well as 
Url) is no longer supported. BibDesk  developers plan to deprecate the use of local file URLs and favor the use 
of aliases instead, which are always shown in the right side pane and are listed under the heading Local Files. 
The advantage being not only that file links are shown in the right side pane, but also that you can even move 
such files on your disk, yet the links do not break. Similarly for URLs pointing at web sites. Once converted they 
are listed under heading Remote URLs and are also shown on the right side pane. Therefore, remember, it is in 
general safer to convert File and URL Fields for all records, before transferring records back to LiteratureMY! If 
it doesn’t help, it shouldn’t hurt either. 
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This marking of records is of a temporary nature and allows you always to find those records, 
that have not yet been transferred back to LiteratureMY. Once you have completed a transfer 
to LiteratureMY and come back with it to BibDesk, this mark will be gone. 

To actually accomplish the transfer, simply switch to LiteratureMY and choose FileMaker 
script «Import from BibDesk». Always ensure that the wanted records are currently selected 
in BibDesk or the entire library will be transferred. The wanted data are first sent to a scratch 
EndNote bibliography (file ‘refs.enl’ in your Literature work folder), which should only 
quickly appear and then imported into LiteratureMY (see also Appendix A2 «Transferring 
records (Overviews)»). You should now see in LiteratureMY something similar to this: 

 

You are done and best is to delete any records from the BibDesk file in which they were acquired once 
the transfer to LiteratureMY is completed. It is in general recommended to consider the BibDesk file in 
which you acquire records merely as a scratch working area, reserved for acquiring records. Actual 
use of records is best done in separate BibDesk files, that are dedicated to particular projects such as 
writing a paper or a thesis. Remember, BibDesk files are actually regular BibTEX files. Yet, such 
project specific bibliography files are useful in any case, i.e. regardless whether you write with 
LaTEX or Word (given you performed also the optional customizations relevant for temporary 
EndNote citations, see above Section «Customizing BibDesk»). 

Some final comments on caveats with URLs: LiteratureMY maintains only a single entry in the field 
URL and through the transfer only one entry survives in that field. This is the one with the highest 
relevance, typically the one shown at the top of the right side pane of BibDesk’s windows. However, 
this does not mean only one thumbnail survives the transfer. In fact, the transfer is very sophisticated 
and tries to make good use of all information contained in the right side pane. The following holds: 
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• Pdf links are maintained and properly transferred109 

• DOI URLs are discarded after having extracted the DOI and stored it into the field 
DOI110 

• If no actual DOI is defined for the work, the field DOI may also hold an URL of the 
form “http://…”. Typically this is the URL, which was at the top of BibDesk’s right 
side pane (priorities go from top to bottom). 

• Similarly, ISI WOS record numbers are shown as a <Goto ISI> Link, given such a 
link does not conflict with an actual URL that starts with “http://…”.111 

In above example, entering the permanent JSTOR link into the field URL will give that entry 
priority and that’s also what you see in above example. Should there also have been an actual 
DOI URL in the right side pane of BibDesk’s’ window, i.e. one starting with 
“http://dx.doi.org/…”, that URL would be gone. But don’t’ worry, its actual DOI would have 
been preserved and properly stored in the field DOI. 

Data transfers are conservative and in general no data should get lost during transfers. 
However, there is one notable exception: End of lines within the field Comments do not 
survive. As of this writing, once they arrive in BibDesk’s field note, all data are wrapped and 
filled into the field. Incidentally, this is fortunately not the case with the field abstract, which 
preserves paragraph structuring. 

If you frequently transfer records back and forth between BibDesk and LiteratureMY I 
recommend to define keyboard shortcuts in the System Preferences pane Keyboard & Mouse 
for FileMaker, following the technique as described in Section «New helper scripts». I use 
Control-6 (for export) and Control-7 (for import) in analogy to Command-6 (for export to 
EndNote) and Command-7 (for import from EndNote) as provided by default for the 
FileMaker  transfer scripts in LiteratureMY. 

1.9.3 TRANSFERRING RECORDS INTO AND FROM B IBDESK  

Transfers of records are possible among all three main components of our system, i.e. 
LiteratureMY (FileMaker), EndNoteMY (EndNote), and BibTEX (BibDesk). The transfer of 
records between LiteratureMY and BibDesk is described at the end of the Section «Using 
BibDesk - a short tutorial». This covers even the transfer of records from BibDesk to EndNote, 
since the transfer from BibDesk to LiteratureMY takes place via EndNote. The only missing 
transfer not yet covered is that from EndNote to BibDesk. This transfer is also possible, albeit 
some restrictions may apply (see also Appendix «A3 Transferring records among applications 
– possibilities and restrictions»). To accomplish this transfer, simply select the records in 
EndNote, choose as output style the provided style ~BibTeX Export and choose menu 
command “Edit -> Copy Formatted” (Cmd-K). Then paste the clipboard into any BibDesk 
data base. In case of difficulties, please consult Appendix «A3 Transferring records among 
applications – possibilities and restrictions». 

 
109 LiteratureMY may actually ask you to specify the folder where you keep your pdf’s before initiating a 
transfer to ensure that this information is always also properly transferred. 
110 This works also for URLs that have the DOI hidden somewhere in them, given the keyword ‘KeyUT=’ could 
be found in an URL that starts with “http://gateway.isiknowledge.com/…” 
111 unless that URL should be redundant (e.g. with the one stored in field DOI) then the <Goto ISI> Link will be 
favored. 
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1.9.4 APPLESCRIPTS OFFERED IN B IBDESK’S SCRIPT MENU  

The following AppleScripts are made available in BibDesk’s script menu  (for shortcuts 
for these AppleScripts see above Section «Recommended shortcuts»): 

“Cleanup Duplicates” Any publications imported newly into BibDesk are 
kept and their outdated duplicates by cite key 
deleted. This assumes the reimport served an update 
(see also “Select Obsolete Duplicates”). 

 “Cleanup PDF Repository” Any pdf’s at the root level of your pdf repository 
folder are stowed away to their proper locations, i.e. 
the subfolders corresponding to the first letter of the 
file names (same functionality as Folder Action 
script “Do Autofile”). 

“Delete Abstract” Delete for currently selected publications the 
abstract. This optional script112 is mostly of interest 
in conjunction with a shortcut and when you need to 
replace frequently abstracts with new ones from the 
clipboard, i.e. when you wish to make space before 
calling the companion script “Fix-Paste Abstract”. 

 “Delete Publication” Delete the currently selected publication(s). This 
script is of interest if you wish to delete an 
erroneously imported publication, e.g. it was 
imported twice or got during importing a wrong cite 
key, or you have otherwise already assigned a final 
cite key, which you wish to make usable again. 
Then it is recommended to select those unwanted 
publications and execute this script, which is the 
better technique than to delete merely the 
publication using BibDesk’s delete function. Using 
this script avoids the cite key being falsely 
remembered as already used. 

 “Dump CodesMY” Get the latest codes from LiteratureMY for creation 
of cite keys avoiding conflicts (generates a new 
auxiliary file DumpOfCodesMY.txt in your 
Literature work folder). 

“Export to EndNote” Export selected publications to EndNote (via XML 
format) into bibliography file refs.enl residing in 
your Literature work folder. 

“Extract Bibliography” Extract selected publications together with copies of 
their linked files to some choosable target folder. 
This script creates a html page at the root of the 
target folder. That web page contains abstracts, 
active DOI and URL links, and links to the copied 
pdf’s for independent reading or publication on the 

 
112 Optional means the installer script SE_BD_Installer.command quietly skips installation if the script is not 
present. 
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web, e.g. for colleagues when writing a paper. This 
technique allows also to create archives that can be 
burnt onto DVD’s. Such an archive can be read 
independently from BibDesk or any other 
component of the LiteratureMY system and needs 
only a browser. 
 
Note: By default the name index.html and the default title 
Bibliography are used. The optional file MakeFileIndex.DTF 
can be used to override this behavior and to specify the 
name113 of the index file and the title114 used in the index file. 
Note also that MakeFileIndex.DTF can be used easily to 
override other parameters115 of the extraction process as done 
by this AppleScript116. To customize the appearance of the 
index file, e.g. colors or fonts, use the CSS style sheet.117 

“Extract For e-Reading” Similar to “Extract Bibliography” but uses always a 
fixed destination folder, which is reserved for 
reading of pdf’s with an iPad, iPhone or iPod Touch 
etc. The idea is to dedicate a particular folder, the e-
Reading folder118, which is then typically synced via 
the cloud, e.g. by using a DropBox119 or 
SugarSync120 folder that is easily synced with an 
external device. I regularly run this script to extract 
the pdf’s I want to read on the iPad and sync my 
iPad to this folder using GoodReader121. On the 
iPad I launch GoodReader, run a sync, open the 
index file and then jump to whatever pdf I want to 
read. The App GoodReader for the iPad is not only 
an excellent pdf reader and annotation tool, but 
offers also very reliable syncing. Thanks to 
GoodReader I can conveniently sync pdf’s back and 
forth between the iPad and my Mac while retaining 
annotations in pdf’s (see script “Sync Back From e-
Reading”). 
 

 
113 See value definition FileListFile. Editing only this file supports the use of another file name for the index file 
without having to change the code of any of the involved AppleScripts. 
114 See value definition TitleAddon. Editing only this file supports a variable title as used in the index file 
without having to change the code of any of the involved AppleScripts. 
115 See shell script SEHtmlExportPostProcessing.sh for details 
116 Note all this assumes you have customized BibDesk as described under the optional step “Extend your 
Template Files preferences in BibDesk”. See also further details on this behavior as explained there. 
117 See file SEHtmlExportStyleSheet.css 
118 The location of the e-Reading folder is either given by the preference property eReadingFolder within the 
script itself or if that location is not found on your system, as defined by shell variable eREADINGDIR that is 
exported by file ~/bin/LITMYPath.txt (provided with distribution of package EndNote SE Add Ons…, see also 
footnote ^ near footnote 30). 
119 http://www.dropbox.com/  
120 https://www.sugarsync.com/ 
121 http://www.goodreader.net/goodreader.html  

http://www.dropbox.com/
https://www.sugarsync.com/
http://www.goodreader.net/goodreader.html
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Note: If you select first a group, say SMART122 or STATIC 
group or some field group from KEYWORDS and then select 
also all visible publications, the index file and its title are 
named after the group’s name123. Ex.: Selecting a static group 
named Biodiversity and all its publications will result in an 
index file named __Biodiversity.html124 with title Biodiversity. 
Note for this AppleScript that the default alphabetical sorting 
of publications by cite key can be suppressed for some groups. 
List the names of such groups in the AppleScript’s property 
doNotSortForGroups.125 Otherwise the very same rules apply 
for the index file generation, notably with respect to the 
optional file MakeFileIndex.DTF or the CSS style sheet, as 
described for AppleScript “Extract Bibliography”. 

“Sync Back From e-Reading” The companion script to “Extract For e-Reading” 
that synchronizes back to your Mac pdf’s that you 
may have annotated on an iPad, iPhone or iPod 
Touch etc. Say you have synchronized your 
annotations made on the iPad with the cloud, e.g. by 
using GoodReader’s sync command (as described 
for script “Extract For e-Reading”). Then those 
annotations are in the cloud and your e-Reading 
folder, but not yet in your pdf repository folder126 as 
used by BibDesk. Use this script to fully 
synchronize back your annotations.  
 Note, this script syncs back only the pdf’s of 
those publications that you have currently selected 
in BibDesk. To really sync back all pdf’s currently 
contained in your e-Reading folder you need 
therefore first to run script “Select e-Reading 
Publications”.  
 Note also, this script overwrites any pdf in 
your repository folder that is older than the one from 
the e-Reading folder. This is necessary for technical 
reasons and avoids a mess with the Mac’s file 
system that tends to retain aliases or symbolic links 

 
122 See sections in left pane of BibDesk named in this manner 
123 You can also select several groups. In this case only the names of the first two groups are actually used. 
124 Names are prefixed by ‘__’ as defined within the AppleScript (property theIndexFNPrefix, which can be set 
to the empty string if you prefer no prefixes). This facilitates to see index files before and separate from pdf 
folders in the e-Reading folder and/or the iPad. 
125 I specify the property doNotSortForGroups e.g. as follows: {"To Read", "IPCC TAR", "IPCC AR"}. Any 
groups containing these strings will then be exempted from sorting by cite key and the index file shows the 
publications in the order the group is currently sorted. Ex.: Groups "IPCC TAR", "IPCC AR4", and "IPCC AR5" 
are then always exempted and can be sorted by SPM, TS, chapters, and appendices before running this script. 
126 The pdf repository used is precisely the folder as set by BibDesk’s preferences only when using the BibDesk 
scripts “Extract Bibliography”, “Extract For e-Reading”, “Sync Back From e-Reading”, “Select e-Reading 
Publications”, “Extract Index-Abstracts”, and “Fix PDF and URL Links”. Thus make sure configuration 
information from file LITMYPath.txt is consistent with BibDesk’s preference. Only scripts “Cleanup PDF 
Repository” (or the “Did_autofile (BibDesk hook)” and “Do Autofile (Folder Action)”, respectively) can also 
use source file LITMYPath.txt and may warn you if the BibDesk’s preference settings are inconsistent with what 
is defined by shell variables MYPDFDIR1 or MYPDFDIR2 that are exported by file ~/bin/LITMYPath.txt 
(provided with distribution of package EndNote SE Add Ons…, see also footnote ⊥ near footnote 30). 
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to trashed files. Therefore, IMPORTANT Note: 
Always annotate pdf’s either only on the Mac or 
your e-Reader, but not simultaneously on both, 
or you risk loosing some of your annotations! A 
good rule of thumb is also to always sync to the 
cloud on say your iPad after having annotated any 
pdf’s there and to sync back using this script before 
start doing any annotations on your Mac. Note, the 
latter rule of thumb is of course only working well if 
your Mac is automatically synced to the cloud. This 
is the case with DropBox or MobileMe services, but 
requires of course your Mac to have a working 
connection to the internet, or the cloud fails to 
automatically sync to your e-Reading folder that 
resides on your Mac. 

“Fix DOI and Case In Title, Author” Some data base providers define redundantly 
the DOI in form of an extra URL, some list authors 
or entire titles with capitals. This script contains 
several algorithms to cleanup such messy or 
malformed records. 

“Fix PDF and URL Links” If any file links on the right side pane have been lost 
or some URLs are disfunctional because of 
incomplete definition (e.g. www.sysecol.ethz.ch is 
converted to http://www.sysecol.ethz.ch), this 
recreates or fixes them. File links are restored from 
the actual pdf’s present in your pdf repository folder 
given they are named properly, i.e. <cite key>.pdf, 
<cite key>_S.pdf, <cite key>_S2.pdf etc. 

“Fix Zeroes In Cite Key” Script not generally available. This can be used to 
insert zeroes into cite keys as necessary according to 
cite key uses in LiteratureMY. A maintenance script 
useful if records with cite keys Fi98, Fi99, Fi100 are 
assigned cite keys Fi098, Fi099, Fi100 for better 
sorting (see FileMaker script “Insert 0's in main key 
(SECode)” of LiteratureMY). 

“Fix-Paste Abstract” More and more these days abstracts are provided in 
UTF-8 encoding. This script converts for the 
currently selected publications the abstract from 
UTF-8 to Western (Mac OS Roman) encoding. This 
overcomes the difficulty of not being able any more 
to save in BibDesk the current document127. 
Moreover, use this script to enter from the clipboard 
the abstract if you have currently only a single 
publication without an abstract selected. To actually 
replace an existing abstract with a new one from the 

 
127 This is relevant only in the recommended preference settings “Open and export BibTeX files using 
encoding” set to “Western (Mac OS Roman)” 

http://www.sysecol.ethz.ch/
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clipboard, call first the companion script “Delete 
Abstract”. This script is designed such that the 
encoding conversion can be easily changed to 
something else, depending your current BibDesk 
preference settings (“Files -> String Encoding”). 

“How many selected” Use this script to learn how many publications are 
currently selected. Since BibDesk as of this 
writing128 does not display how many publications 
are currently selected, this script is useful when you 
currently have a large and complex selection, yet 
need to be sure how many publications are actually 
selected. Typically this script comes in handy when 
the selection is the result of another script. 

“Import by DOI” Use this script if you know the DOI of a publication 
and wish to import it into BibDesk. 

 “Inspect Linked Files” Use this script to learn about type (e.g. symbolic 
link vs. alias vs. actual file) and to which files the 
actual file links go (see also “Fix PDF and URL 
Links” and “Cleanup PDF Repository”). 

“Link PDF from Adobe Reader” Link the frontmost pdf currently opened in Adobe 
Reader to the currently selected publication (unlock 
if secured and PDFKey Pro’s command line tools 
are installed). 

“Make PDF Alias” Creates an alias to a pdf residing in a non-standard 
location as a portable symbolic link. For instance 
keeping chapters of an entire book within a 
subfolder named according to the cite key of the 
record for the entire book, allows nevertheless to 
have for each individual chapter its own <cite 
key>.pdf file at the proper location without having 
to store the pdf redundantly. This saves space and 
supports easier maintenance, e.g. if pdf’s are made 
searchable via Acrobat’s OCR feature. Symbolic 
links are also preferable when synchronizing the pdf 
repository among several Macs and for archiving. 

“S-F-X Linking” If enough information is contained in the 
publication record of a journal article, jump to the 
proper web page (access restricted and requires well 
defined fields ISSN, Year, Volume and Pages). 

“Search By Title In Clipboard” Similar to its companion script “Show In 
LiteratureMY” this script helps you to search for the 
presence of a record either in LiteratureMY or in 
any currently open BibDesk documents. However, 
this script searches for all records with a title that 
contains the current content of the clipboard not 

 
128 Version 1.6.5 (3713) 
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only in LiteratureMY but also in all currently open 
BibDesk documents. Therefore this script is 
typically used to get a complete overview over all 
records containting a particular title phrase not only 
in LiteratureMY but also in all currently open 
BibDesk documents. This script is also useful before 
deciding to import a record into BibDesk and helps 
you to avoid redundancies in your literature data 
base. This script informs you what it could find or 
failed to find via an audio message and selects any 
found record(s).  
 In contrast to its companion script “Show In 
LiteratureMY” this script uses any text currently 
contained in the clipboard as the title (or part of the 
title) to search for a publication, which means it 
needs no publication to be currently selected and 
ignores cite keys. Since this script informs you 
regardless of any current selection in BibDesk, it 
informs you about all records found in the system, 
including any currently possibly selected ones. This 
script can assist you when merging entire data 
bases, e.g. when merging records from multiple 
BibDesk documents in a single one. 

“Select e-Reading Publications” Select in the current BibDesk document all 
publications that have a pdf in the e-Reading folder 
(see script “Extract For e-Reading”). This script 
allows for checking the consistency between your 
BibDesk documents and the pdf’s actually contained 
in the e-Reading folder. Since you can easily add 
pdf’s to the e-Reading folder on an iPad, e.g. by 
downloading pdf’s, inconsistencies between the e-
Reading folder and your BibDesk data may arise 
quickly. Within BibDesk you may have a static 
group for pdf’s to be read or a smart group looking 
at the ‘Read’ field. This script is a great help in 
finding out about possible inconsistencies between 
such a group and the e-Reading folder. Note, this 
script logs all unmatched cite keys (for name of log 
see preference property theUnmatchedCiteKeys). 
Inspect this log using Apple’s utility Console, e.g. 
for subsequent manual fixing of the inconsistencies.  

“Select Obsolete Duplicates” Selects the older publications of duplicates by cite 
key (see also “Delete Duplicates”, which does more, 
i.e. it deletes the publications which would have 
been selected by this script). 

“Select Top Publication” Useful only if a shortcut, say Ctrl-A, is associated 
with this script. This is a quick way to select the 
publication listed at the top in the current BibDesk 
document without having to use the mouse. This 
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comes handy when you wish to link a pdf to a just 
imported publication and perhaps many more uses. 

“Show In LiteratureMY” Checks whether the currently selected publications 
are already contained in LiteratureMY and shows 
them there as the current find. This script is most 
useful before deciding to import a record into 
BibDesk or to quickly find the counterparts in 
LiteratureMY. This script informs you what it could 
find or failed to find via an audio message and 
selects any found record(s). 
 Note the script searches by title if no cite key 
has yet been assigned to the record and thus may 
miss finding a misspelled record in LiteratureMY. 
Note also, once you have already imported the 
record and assigned a cite key, this script will not 
find redundancies in LiteratureMY anymore. This 
script can also help you assigning a cite key and 
transferring additional data from LiteratureMY to 
your currently selected publications in case of a 
match, assisting the merging of entire data bases. 
The latter is done only after asking you for 
permission on an individual basis, i.e. record by 
record basis. 
 Note this script has a companion script, i.e. 
“Search By Title In Clipboard”, with a similar 
functionality, yet with subtle differences. The 
companion script “Search By Title In Clipboard” 
always searches only for matching titles and needs 
to have the string to search for in the clipboard 
regardless of the current selection in BibDesk. 
“Search By Title In Clipboard” also searches in in 
all currently open BibDesk documents, which may 
be particularly useful when you have several 
BibDesk documents open at the same time. Again 
this can assist you when merging entire data bases. 

“Update BibDesk” Gets the latest nightly build of BibDesk and installs 
it. 

“Use Camino” The default browser used by BibDesk is Camino. 
“Use Default Browser” The default browser used by BibDesk is the system 

wide default browser, typically Safari or whatever 
your system’s configuration may be. 

“WOKSearch Availability” This script informs you about the availability of the 
WOKSearch Premium service129 as offered by 
Thomson Reuters at your current location/institution 
and as used by the standard BibDesk menu 

 
129 The ISI Web of Knowledge Web Services, version 2.0, are needed here. Find details on these services here: 
http://search.isiknowledge.com/esti/cxf-wsclient-demo/docs/soap/index.html  

http://search.isiknowledge.com/esti/cxf-wsclient-demo/docs/soap/index.html
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command “Searches -> Web Of Science SCI”.  
 Since 31st August 2012 Thomson Reuters has 
split previous IP# authenticated searches of its data 
bases into a WOKSearchLite and a WOKSearch 
Premium service (the latter simply named 
WOKSearch). Not all these services may be 
available to you and notably the WOKSearch 
service may be offered only in a reduced form, i.e. 
in a throttled down manner that allows only access 
by a certain number of queries, say 5, in any given 
query period, say 5 minutes. Use this script to learn 
if at all and notably by when such a service becomes 
again available to you.  
 If the service has exhausted its limits this 
script can be called within the exhausted query 
period as many times you like without risking any 
penalty. Otherwise you have wasted one query. 
Thus avoid calling this script more than really 
needed.  
 For this script to work you need to have the 
auxiliary perl script ‘woksearch.pl’ stored in the 
same folder as this Script and installer script 
‘SE_BD_Installer.command’ has been run success-
fully to make that perl script known to your system. 
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2. Maintenance 

2.1. Avoiding redundancy 

Unless you search each time before entering a new record in a disciplined manner whether a 
publication is already contained in our system, your data base LiteratureMY may contain 
redundant entries. Remember the scripts "Find in field Author(s) in all data bases" (Cmd-8) 
and "Find in field Author(s), Year, Title in all data bases" (Cmd-9) support you in searching 
for already existing records. To discard redundant records, you need first to be able to find 
them. The new script "Find similar/redundant" supports you in accomplishing this. It offers 
to be run in two modes: 

• Redundant - This script searches for any records of journal articles, which have the 
same authors, title, year, volume and page numbers.130 Such records are generally 
redundant. 

• Similar - This script searches for records with a similar title regardless of 
information contained in the other fields. Since FileMaker has only a limited 
capability to detect similarities131, the found records may or may not be redundant. 
Thus, you have to decide.  
 
To make the use of the script "Find similar/redundant" in mode Similar more 
convenient for you, you may mark records with value "SimilarOK"132 in field InInd 
133if that record is actually not redundant. Any records such marked can then be 
omitted the next time you use this script again. This way you don't have to inspect 
and decide all over again whether similar records are actually redundant or not.  

You should permanently delete extra records referencing the same publication till you have 
only one left. Remember, always use script "Delete record permanently" to delete such extra 
records! 

 
130Note, however, it won't find redundant, but incomplete records or records with typing errors. E.g. if you 
entered for the same article only incomplete information by omitting page numbers or misspelled something, 
those record won't be found. Punctuation marks and blanks, however, are of no relevance. Thus, two records 
having unequal number of blanks between words of a title are found to be redundant; but two records having a 
difference in one word, e.g. because you mistyped once a name, they are not found to be redundant. 
131As of FileMaker Pro v6.04 only up to the first 20 characters per word and only up to a total of 60 characters 
are considered in any comparison while searching for duplicates. It is currently not known whether this 
restriction still applies for later verisons of FileMaker. 
132This value is interpreted to mean also that the record is not in the card index, i.e. value "SimilarOk" is to be 
interpreted to imply also value "n". Notes, the values “y” and “n” are there only for legacy reasons and since any 
contemporary record was entered from other sources than the legacy card index, the value “n” is implicitly 
implied unless a “y” is present in this field. Note, the field InInd may now also hold additional information about 
where the record was acquired, i.e. whether its main key (SECode) was issued while the record was in 
LiteratureMY (FileMaker) or in a BibDesk managed BibTEX bibliography. Any record initially acquired using 
BibDesk may contain here also the value “BibDeskEntered” in addition to “SimilarOk”. However, the 
information on the source of a record is only of limited relevance, while the marking with “SimilarOk” may 
facilitate the searching for redundancies in large bibliographies significantly. Thus ensure this information is 
preserved while editing field InInd. 
133 This field is labeled InInd but is actually internally the field named InCrdIndex.  
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2.2. Changing the Main Key SECode 

While consolidating a data base LiteratureMY, it may become necessary to change the main 
key (SECode134) of a record, despite rule 7 as stated on p. 26 of FISCHLIN & NEMECEK (2001). 
This may become necessary to get rid of wrongly catalogued records, which then become 
duplicates. To this end use the following helpful buttons:   

The button New Code is typically used after having duplicated a record with script Duplicate 
record (see Section «New Helper Scripts»). 

The button Restore Code is normally used to restore an accidentally changed main key, e.g. 
after editing the authors and accepting the changed key despite the warnings. However, button 
Restore Code can do more than just that. It is particularly powerful if used in the layout 
Maintainers Layout. There you may enter any main key into the field SavedCode and press 
the button. This way you can force any main key onto a record (even change the owner, see 
also below)! E.g. enter any new key into the field SavedCode in the Maintainer's Layout  

 

and press button Restore Code, the result will be a key exactly as you have entered it in field 
SavedCode135.  

Since changing the main key threatens in general the integrity of the literature data base 
system, you should make use of these functions only when you are sure the wanted key is 
correct and while you have access to the internet. The scripts will then make great efforts, the 
central data bases, notably LiteratureSE, will stay consistent with the changes you are 
making. Note, if there should be a pdf- or war-file available for the record, it will also require 
renaming. The button's scripts will take care of that automatically136. Therfore it is again 
recommended to have internet access, in case you store your pdf-files on a file server.  

 
134 This field is labeled SECode but is actually internally the field named SysEcolCode.  
 
135You have to dismiss all warnings and insist on continuing with the script to force this result! 
136 Watch out whether the script informs you about having renamed pdf- or war-files if you use the buttons 

 
the first time. Sometimes the involved AppleScript requires to be activated before it 

actually executes. If you suspect that it does nothing and requires activation, proceed as follows: Open the 
FileMaker script «Rename pdf and/or war to new SysEcolCode (internal)» by selecting it and clicking the Edit… 
button. Then select the Perform AppleScript step and click the Specify… button. Click twice the OK button and 
Done button and the script should now work and rename all involved pdf’s and report about its 
accomplishments. Check it out and possibly repeat above steps if necessary. 
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Remember, there is also the script named Change Owner to Me. It is much more convenient 
than above procedure if your only motivation is only to change the owner. It does change the 
owner of the current record to you, given the previous owner is no longer active. As a 
consequence, the main key changes. Again you should follow the rules described above, i.e. 
use this script only while you have access to the internet. Again, possibly present pdf-files or 
war-files will be automatically renamed as well. This is all most convenient, preserves the 
overall integrity of the data base system and is therefore the recommended technique to 
change the owner. 
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2.3. Using 0 instead of hard blank in the Main Key SECode 

Under MacOS X 10.2.x Microsoft's Internet Explorer hangs forever and can't open a pdf-file 
whose name contains a hard blank. This is a nuisance, e.g. while reading your personal pdf 
collection from the file index.html, which was generated by utility MakeFileIndex. I have not 
been able to find a method by which this problem can be overcome. Thus it is advisable to 
stop using hard blanks in the main key of the records. Instead you should use a digit, i.e. 0. 
This will allow to sort easily all records in ascending order, both within the FileMaker as well 
as for the electronic reprints such as the pdf-files in the Finder, yet files can easily be handled 
on basically any operating system137.  

As of version 1.7 of our literature data base system we use the new method without any hard 
blanks. This is now the default method and I advise against going back to the old method 
(albeit this is theoretically still possible138). The new method affects any creation of new keys 
(SECode), given you have also discarded/upgraded your CodesMY exactly as described for 
step 3 in FISCHLIN & NEMECEK (2001) on p. 10 while you have upgraded your personal 
literature data base. 

To fix really all keys which still contain hard blanks, i.e. those from the records entered 
previously, use the script Insert 0's in main key (SECode). However, it is highly 
recommended to execute this script only after having done the following: 

- Textual backup of your personal data files LiteratureMY and CodesMY by using the 
scripts Archive as TEXT file (MERGE format)... 

- Perform a fully successful upload/merge of your records from LiteratureMY (script 
Upload/Merge to LiteratureSE...) 

- Make sure you have access to the internet, notably LiteratureSE and that your 
collection of pdf- or war-files is fully accessible as well. 

Now it should be safe to run the script Insert 0's in main key (SECode). The result should be 
an entirely consistent data base without any hard blanks in the records you own. This means 
all fine (i) in your records within LiteratureMY, (ii) in your collection of pdf- and/or war-files, 
and (iii) in in LiteratureSE all copies of the merged records you own with master rights. All 
should now be uptodate without any hard blanks but 0 instead. 

 Recommendation: It is advisable to first run script Insert 0's in main key (SECode) 
with only a few records in the current selection. Once you have familiarized yourself 
with the procedure and all went well, it is safe to run the script also with all your 
records unless you have thousands of them. However, you should exclude the 
dummy record at the begin of the data base. It is easy to get this needed selection by 
executing the script Find all (except records to be ignored). Normally this script is 
hidden, i.e. not shown in the menu Scripts. Execute it after having opened the menu 
command Scripts > ScriptMaker... 

 
137The hard blank (character 202 decimal on a Macintosh, UTF-8 160) is a non-ASCII character and thus 
platform dependent. Sticking to merely standard ASCII characters is an easy as well as robust method to achieve 
the same result as with a hard blank.  
138 In Maintainer's layout you can set the global variable prefixCodeCh accordingly. 
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Once you have translated all main keys in all your records properly, you should immediately 
upload/merge your LiteratureMY once again (script Upload/Merge to LiteratureSE...). This 
will make the transition considerably easier. Note, records which needed no change of the key 
will remain unaffected by the script Insert 0's in main key (SECode), even when they are 
within the selection. Thus the upload/merge will involve only records of which the key has 
actually changed. 

Note, any records you merely share and where you have no master rights to modify them, will 
still contain keys with hard blanks. Thus it is highly recommended to make the transition to 
the new method in cooperation with all users. Once all users have updated their records, you 
need simply to discard all records you share (hidden script Find mine I share (owner is 
someone else)) from your LiteratureMY and download the ones you share once more. Records 
you share owned by a former, i.e. no longer active member of Systems Ecology will still 
contain hard blanks. Use script Change Owner to Me to take responsibility for those records. 
Then the result should be a data base without any hard blanks in the main key (SECode) 
throughout all records. Use script Download/Extract My Records From LiteratureSE with 
options Shared  

 

and No, all!. 

 

Note you can run the script Insert 0's in main key (SECode) also anytime later, e.g. when you 
wish to add an extra 0 in front of all keys with a number less than 100. This is of course only 
necessary if you have more than 99 records for a given author abbreviation. 
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In such a case simply press the button 3 digitsinstead of the default 2 digits. 
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2.4. Checking FileMaker relationships 

The literature data base system ceases to function properly if so-called relationships between 
various involved files are not properly defined. FileMaker can dynamically change and 
remember these settings, which is sometimes useful and sometimes a nuisance. If you suspect 
such a problem, you can easily check the current definitions of relationships by using the 
menu command Define Relationships.... Note you should do this check only if you are 
connected to the Internet and know the passwords for the central data base files! 

The relationships should look exactly like this in LiteratureMY and CodesMY (here shown 
with MY as AF): 
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The auxiliary files, which have some relationships, should have them defined like this: 

 

 

If you encounter an error message similar to this 

 

then a relationship may be broken. In such a case it is best to select the needed file and fix this 
way the broken relationship139.  

 
139In particular in OS X it is most convenient to switch to the Finder and make the needed file ready, should it 
actually be missing. Then resume the script. 
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Don't confound such an actual error condition with the normal establishing of a relationship to 
your personal files. If you are using for the very first time a feature, which needs to establish a 
relationship with a personalized data base file, you may encounter a similar error message. 
E.g. it may be the following message 

 

However, you can easily tell such a message apart from a real error condition. If the missing 
file is either LiteratureXY, CodesXY, or LiteratureMY, then it is NOT an error condition. The 
example shown above is normal and needs only to know the name of your LiteratureMY data 
base file. In all these cases you are expected to select once the wanted file. Once selected, 
your data base system should remember your selection and there is no longer any need to ask 
you again.  

In all cases where you have actually encountered an error condition, you should report140 this 
to the maintainers of this data base. Thank you! 

 
140Please write down error message and name of script in which you have encountered this error. Try otherwise 
to take a note of the state your data base system was in when you launched the script.  
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2.5. Conversion utilities 

Under Mac OS X there are now many comand line tools available, which can be quite useful 
for converting data. With OS X comes the powerful iconv. Other utilities, e.g. utf82mac or 
rtf2txt, are installed by default if you complement the basic EndNote installation with our 
EndNote SE Add Ons.  

iconv This essential and very powerful conversion utility is at the heart of 
many conversions done using Mac OS X. It is very complex and its 
use may not always be very simple, but it is the main conversion 
workhorse recommended to be used for reliable conversions.  
 
To learn more type in a terminal window of application Terminal: 
  
 man iconv  
 
Note, several of our AppleScripts and shell scripts use iconv. 

utf82mac This utility converts UTF-8 encoded text to Western Mac OS Roman. 
It uses iconv to do the actual conversion. To learn more type in a 
terminal window of application Terminal:   
 
 utf82mac -h  
 
Note, this script may be used as a filter with BibDesk when opening a 
UTF-8 encoded file (menu command "File -> Open Using Filter...") by 
entering as the Filter Shell Command: ~/bin/utf82mac. 

rtf2txt This utility converts a rtf file into a mere text file. By default Mac OS 
Roman text encoding results, which used to fit nicely into our system, 
notably the traditional encoding used by the FileMaker data base 
LiteratureMY. However, note this utility is deprecated and is no longer 
maintained, yet it may be useful for debugging purposes if PPC code 
can still be executed (up to and including Mac OS X 10.6.8 Snow 
Leopard).  
 
To learn more type in a terminal window of application Terminal: 
  
 rtf2txt -help  
 
or visit  
 
 http://www.bluem.net/de/mac/resterampe/ 

textutil This Mac OS X utility serves as of this writing as a replacement for 
utility rtf2txt and is used during all transfers from either EndNote or 
BibDesk to FileMaker data base LiteratureMY.  
 
To learn more type in a terminal window of application Terminal: 

http://www.bluem.net/de/mac/resterampe/


Latest Additions Literature November 12, 2024 

83 

  
 man textutil  
 
Note, several of our AppleScripts and shell scripts use textutil. 

deTeXforBD.sh This utility converts TEX encodings to the single LaTEX format 
BibDesk accepts and helps further by converting some special 
characters BibDesk cannot “deTeX”, e.g. °C, to the encoding as 
currently set in BibDesk’s preferences. This is particularly useful in 
case you wish to use some citation export from a website that uses a 
different TEX encoding for special characters than the one BibDesk 
uses. To learn more type in a terminal window of application 
Terminal:   
 
 deTeXforBD.sh -h  
 
Note, several of our AppleScripts and shell scripts use the same 
algorithm as this utility. 

 

Bibutils They allow to convert to and from several formats such as BibTEX or 
EndNote Refer Format to a central, common format MODS or XML 
intermediate, which is the Library of Congress's  Metadata Object 
Description Schema (MODS).  
 
For example the utility end2xml could be used to convert file refs.txt 
resulting from an export of FileMaker data base LiteratureMY to 
EndNote (see also Appendix A2) into a MODS formatted file.  
 
To learn more visit  
 
 http://sourceforge.net/p/bibutils/home/Bibutils/ 

 

The following sites are useful to learn more about formats in which bibliography data are and 
can be stored: 

MODS http://www.loc.gov/standards/mods/ 
 

BibTEX http://nwalsh.com/tex/texhelp/BibTeX.html 
 

http://www.fb10.uni-
bremen.de/anglistik/langpro/bibliographies/jacobsen-bibtex.html  
 

http://en.wikipedia.org/wiki/BibTeX 
 

Refer http://lucy.ukc.ac.uk/makhzan/refer.html 
 

http://www.loc.gov/standards/mods/
http://nwalsh.com/tex/texhelp/BibTeX.html
http://www.fb10.uni-bremen.de/anglistik/langpro/bibliographies/jacobsen-bibtex.html
http://www.fb10.uni-bremen.de/anglistik/langpro/bibliographies/jacobsen-bibtex.html
http://en.wikipedia.org/wiki/BibTeX
http://lucy.ukc.ac.uk/makhzan/refer.html
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http://web.archive.org/web/20080115060458/ 
 

http://www.ecst.csuchico.edu/~jacobsd/bib/formats/refer.html 
 

RIS http://www.refman.com/support/risformat_intro.asp 
 

http://www.adeptscience.co.uk/products/refman/reference 
 

General http://web.archive.org/web/20080115060453/ 
 

http://www.ecst.csuchico.edu/~jacobsd/bib/formats/index.html 

http://www.ecst.csuchico.edu/~jacobsd/bib/formats/refer.html
http://www.adeptscience.co.uk/products/refman/reference
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2.6 Importing into EndNote the term list Journals 

As of EndNote 8, importing a term list into EndNote has become difficult. This is particularly 
relevant for importing the journal list as generated by the FileMaker auxiliary file 
Journals_at_ETHZ (Script «Make EndNote Journals Terms List»). Follow this procedure to 
succeed: 

1) Open the Term List in a text editor, e.g. TextEdit (recommended) 
2) Make certain that the last line is blank (a simple carriage return at the end of the last 

line of actual text) 
3) Save the file with UTF-8 encoding 

Then import the thus prepared file into EndNote. Note, that term lists are stored in the 
accompanying folder ....Data, not merely in the file ....enl. 

In addition you have to make sure the list gets not corrupted. You need to adjust the settings 
in your EndNote bibliography file. Notably prevent any links affecting this field, i.e. all links 
by using the menu command "Tools -> Link term Lists...". 

Finally you have also to prevent that any importing or pasting of records corrupt your term 
lists. Set the EndNote  preferences for Term Lists as follows: 
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Appendix 

The following pages may be particularly helpful if printed and kept handy. For further details 
on exporting to EndNote please consult Section «Exporting to EndNote ». 
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A1 Acquiring new records (workflow diagrams) 

Method 1 using LiteratureMY and EndNote 

  



Latest Additions Literature November 12, 2024 

88 

Method 2 using LiteratureMY and BibDesk 

 
 
Note, BibDesk file Some Refs.bib could have any name, FileMaker file LiteratureAF is an example for LiteratureMY 
1: Optional step 
2: Assumes you know that the publication is new and not yet entered into the data base, otherwise you risk to reenter the 
same publication. You will then have to delete it once the test for presence made below should be positive. However, only a 
few journals do support this functionality. 
3: Make sure you are connected to the internet and properly authenticated, then use “Searches -> Web Of Science SCI” or 
“Searches -> PubMed” or “Searches -> NEBIS” (for query syntax see below and last Appendix)  
4: If it is a journal article ISI WOS (Web Of Science) or PubMed may list it or the journal you are browsing offers BibTeX 
export (many do). If it is a book NEBIS may list it. 
5: This script informs about its results by speech only. 
6: For this you need to switch to FileMaker and make sure the proper record is currently shown in LiteratureSE 
7: Scripts such as “Fix DOI and Case In Title, Author” or “Fix-Paste Abstract” may help. 
8: Download pdf’s only as needed (a pdf may already be available if sharing only a record from LiteratureSE). Whenever 
possible use script “Link PDF from Adobe Reader”, given you have the corresponding record currently selected in BibDesk 
and Adobe Reader has the pdf frontmost opened. Then this script will link, rename, and store the pdf properly in the pdf 
repository without any further user intervention needed. 
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Above diagrams show only major workflows. There are many more possibilities, which are 
not shown here. 

Citations exported for BibTeX are often errenous bib-files and can then not be imported into 
BibDesk without throwing error messages and aborting the import. Manual fixing of the data, 
e.g. by inventing a cite key and reimporting the edited copy may help to overcome this 
difficulty. On the spot invented cite keys need then of course later be overwritten with a 
proper cite key. If encoded as UTF-8 BibDesk may much better import such bib-files when 
using command “Files -> Open Using Filter…” and then choosing as filter the provided 
utility ~/bin/utf82mac141.  

The query syntax to use depends on the service in which you are searching and whether you 
are searching with a browser, BibDesk, or EndNote. When you use BibDesk to search find in 
the Appendix «Searching in BibDesk – Query Syntax Summaries». Here some hints on other 
useful sources explaining how to search meta data from publications: 

 
PubMed 

http://www.ncbi.nlm.nih.gov/books/NBK3827/#pubmedhelp.PubMed_Quick_Start  

http://en.wikibooks.org/wiki/How_To_Search/PubMed 

http://www-fgg.eur.nl/medbib/Manuals/M201e_PubMed.pdf  

http://biomed.ucsd.edu/pubmed/pmfields.pdf  

 
NEBIS 

http://opac.nebis.ch/ALEPH/-/start/nebis-eng  click on Help 

 
ISI WOS/WOK 

https://images.webofknowledge.com/WOKRS512B4.1/help/WOS/hp_search.html  

https://images.webofknowledge.com/WOKRS512B4.1/help/WOS/hs_search_rules.html  

The provided perl script woksearch.pl as distributed with our BibDesk Support folder allows 
also to inquire the so-called WOKSearchLite and WOKSearchPremium web services based on 
the SOAP interface of the Thomson Reuter’s data bases known under ISI WOS or now ISI 
WOK. You can run this script from any Terminal window, but know that this script works on 
a very low level. Those services are described here: 

http://search.isiknowledge.com/esti/cxf-wsclient-demo/docs/soap/  

http://wokinfo.com/media/pdf/WebServicesLiteguide.pdf  

 
141 Utility Transferring records 2mac is made available and installed as part of our EndNote SE Add Ons. 

http://www.ncbi.nlm.nih.gov/books/NBK3827/#pubmedhelp.PubMed_Quick_Start
http://en.wikibooks.org/wiki/How_To_Search/PubMed
http://www-fgg.eur.nl/medbib/Manuals/M201e_PubMed.pdf
http://biomed.ucsd.edu/pubmed/pmfields.pdf
http://opac.nebis.ch/ALEPH/-/start/nebis-eng
https://images.webofknowledge.com/WOKRS512B4.1/help/WOS/hp_search.html
https://images.webofknowledge.com/WOKRS512B4.1/help/WOS/hs_search_rules.html
http://search.isiknowledge.com/esti/cxf-wsclient-demo/docs/soap/
http://wokinfo.com/media/pdf/WebServicesLiteguide.pdf
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http://www.umces.edu/sites/default/files/pdfs/WoK%20Web%20Services%20and%20Discov
ery%20Tools%2006-2011.pdf  

Note, woksearch.pl was mainly written to debug the behavior of those Thomson Reuters services, which have 
changed since August 2012 in a surprising way, which caused any use to fail. This was obviously made in an 
attempt to ask significantly higher payments from academic institutions without providing any new or better 
service by changing the SOAP interface. As of this writing we are still struggling with this service, since 
Thomson Reuters has begun to change unilaterally those interfaces once more in an undocumented manner142. 
We can only hope that the services will regain the former reliability in the near future. 

SOAP interfaces can also be tested with open source tool SoapUI: 
http://sourceforge.net/projects/soapui/  

 
142 The ISI Web of Knowledge Web Services, version 3.0. Published is of this writing only the version 2.0 
services. 

http://sourceforge.net/projects/soapui/
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A2 Transferring records (Overviews) 

A2.1 TRANSFERS BETWEEN ENDNOTE  AND F ILEMAKER  (L ITERATUREMY)143 
 

Summary 

From FileMaker (LiteratureMY) to an EndNote  bibliography file (extension .enl): 

 1 FileMaker script (⌘-6) exports currently in LiteratureMY selected records to currently 
open EndNote  bibliography file (includes conversion in AlphaX)  
 

From any EndNote  bibliography file (extension .enl) to FileMaker (LiteratureMY): 

 2 FileMaker script (⌘-7) imports currently in EndNote  selected (or shown) records to 
currently open FileMaker data base LiteratureMY (includes conversion in AlphaX) 

1 From FileMaker to EndNote  (—>): 

 

2 From EndNote to FileMaker (<—): 

 
 

 

Details (background information useful for stepwise execution or debugging): 
a In AlphaX menu command Merge To Refer from EndNote  Menu converts MERGE 

format (refs.mer) into EndNote  Refer format (tagged format) (refs.txt) 
b Import data from refs.txt into EndNote  using filter EndNote Import (requires presence 

of custom filter file EndNote Import.enf) - AppleScript enImport performs this step 
c Export currently selected records using output style ~TAB Export to FileMaker in rtf 

format (Rich Text Format) to file refs.rtf - AppleScript enExport performs this step 
d Shell script en2fm calling command tool rtf2txt to convert refs.rtf into MacOS Roman 

text file format refs.asc (TAB delimited) 
e In AlphaX menu command EndNote To FileMaker from EndNote  Menu converts 

EndNote  TAB delimited file refs.asc into MERGE format refs.out (step executed by 
AppleScript enAsc2FM) 

 
143 These hints apply only to EndNote  versions 9 and later. 
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f FileMaker script Import from EndNote (quietly from file 'refs.out') (reads MERGE 
format from file refs.out) (step executed by AppleScript enAsc2FM)  

Unfortunately, «From FileMaker to EndNote» (⌘-6) has become a bit less convenient as of Mac OS 
X 10.5.x (Leopard): The FileMaker script does no longer succeed in selecting the file ‘refs.txt’ as 
input for EndNote automatically. This is due to a new restriction in the operating system. You need to 
“teach” your system, which file to import from. Fortunately you need to do this only rarely: The script 
gives you a small time window to select the wanted file ‘refs.txt’ manually by pausing a bit. Once you 
have selected in EndNote  file ‘refs.txt’ for import, the ⌘-6 script should work as intended.  
 In general, if you encounter difficulties while importing into EndNote, it is recommended to 
execute once step b by importing manually ‘refs.txt’ while making sure all settings are exactly as 
described under that step. Note, however, if you have imported from another file, you have to 
“unlearn” your system and to repeat this teaching once again. IMPORTANT NOTE: This teaching 
works only if you have DefaultFolder X installed and active on your system. Remembering the last 
file selected in a folder is THE basic and convenient feature provided by utility DefaultFolder144 (a 
utility configurable via System Preferences). 
  

 
144 http://www.stclairsoft.com/  

http://www.stclairsoft.com/
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A2.2 TRANSFERS BETWEEN B IBDESK  AND F ILEMAKER  (L ITERATUREMY) 

Summary 

From FileMaker (LiteratureMY) to BibDesk file (extension .bib): 

 1 FileMaker script (Ctrl-6) exports currently in LiteratureMY selected records to currently 
open BibDesk  bibliography file  
 

From any BibDesk  bibliography file (extension .bib) to FileMaker (LiteratureMY): 

 2 FileMaker script (Ctrl-7) imports currently in BibDesk  selected (or shown) publications 
to currently open FileMaker data base LiteratureMY (includes above described transfer 
from EndNote  to FileMaker (LiteratureMY)) 
 

1 From FileMaker to BibDesk  (—>) (FM Script Export to BibDesk): 

 

2 From BibDesk to FileMaker (<—) (FM Script Import from BibDesk): 

 
 

 

Details (background information useful for stepwise execution or debugging): 
a FileMaker script (Ctrl-6) exports currently in LiteratureMY selected records to 

currently open BibDesk bib file (accomplishes entire transfer in one step). Use 
Layout View BibTeX Entry to see what is exported. 

b During each transfer this temporary EndNote bibliography file with fixed name 
refs.enl is created from scratch. Transfer fails if such an EndNote bibliography file 
should exist and be currently opened in EndNote. 

c Export currently selected records using AppleScript Export to EndNote from within 
BibDesk to a file with fixed name refs.enl via temporary file refs.xml. File refs.xml is 
written in the EndNote XML format as supported by BibDesk (see also appendix 
A2.3). 
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A2.3 TRANSFERS BETWEEN B IBDESK  AND ENDNOTE  

Export currently selected records using AppleScript Export to EndNote from within BibDesk 
to a file with fixed name refs.enl via temporary file refs.xml (see also appendix A2.2). 
Transfer the records from there to any other EndNote bibliography or rename refs.enl as well 
as the accompanying folder refs.Data according to your wishes. 

Direct transfers from EndNote to BibDesk are also possible by using the Output style ~BibTeX 
Export.ens as released as part of our EndNote SE Add Ons via clipboard (menu command 
“Edit -> Copy Formatted” (Cmd-K) in EndNote, and “New Publications from Clipboard…” 
(Cmd-Opt-L) in BibDesk) or by exporting from EndNote the records first in a temporary file 
such as refs.bib.txt 145, which you open in BibDesk using menu command “File -> Open 
Using Filter…” with filter ~/bin/utf82mac 146. 

 
145 EndNote X. forces you to this and does not allow you to export to a text file with extension .bib. 
146 EndNote X. cannot export proper ASCII text and only exports UTF-8 encoded text files. 
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A3 Transferring records among applications – possibilities and restrictions 

As of this writing it is possible to transfer records freely among following applications: 
• FileMaker (FM  - LiteratureMY) 

• EndNote (EN - EndNoteMY) 
• BibDesk (BD - BibDeskMY) 

In principle records can be transferred among all three above listed applications (see 
Appendix «A2 Transferring records (Overviews)» and Section «Using BibDesk – a short 
tutorial»). However, the following problems may occur and/or restrictions apply (see also 
Appendix «A7 Troubleshooting hints»): 
 
Transfer Field Problem Remedy/circumvention 
EN -> BD clipboard  Saving refused 

because of 
UTF-8 
characters 

Copy the clipboard first into an empty 
AlphaX147 window, select and copy all back to 
the clipboard. That clipboard can not only be 
pasted to BD, but BD will now also save the 
data base 
An alternative, forceful technique is to use 
Carsten Blüm’s wonderful PlainClip148 in 
mode Convert to ASCII. While this always 
works, you risk to lose information, e.g. when 
critical special characters are omitted through 
this conversion. 
Once you have the data in BD, another 
alternative technique is to use in BD the 
AppleScripts Fix-Paste Abstract (if the culprit 
is only within the abstract) or Fix DOI and 
Case In Title, Author (if the culprit is in other 
fields and/or some bad encoding was done by 
the provider, some of which these scripts may 
be able to fix). 

 URL  In BD <Go to 
ISI>:// remote 
link dead149 

Use the superior transfer FM -> BD or run 
AppleScript Fix PDF and URL Links while 
having selected the faulty publication(s) 

In BD Side 
pane 

Wrongly named 
pdf 

Choose menu command “Publication -> 
Autofile Linked Files…” while having selected 
the faulty publication(s) 

In BD Side 
pane 

Dead pdf link An alias named <cite key>.pdf may need to be 
fixed to point properly again at the original file 
possibly stored within a nested subfolder in 

 
147 As of this writing this technique works with AlphaX 8.2b13 and BibDesk Version 1.3.21 (1602) 
148 Available from http://www.bluem.net/en/mac/plain-clip/  
149 If you install in BibDesk the hook Import Publications to use AppleScript Fix PDF and URL Links, this 
problem should not show up and be automatically fixed by the hook 

http://www.bluem.net/en/mac/plain-clip/
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your pdf repository. Run AppleScript Make 
PDF Alias150 while having selected the faulty 
publication(s) 

In BD Side 
pane 

Superfluous or 
missing pdf or 
URL links 

Run AppleScript Fix PDF and URL Links 
while having selected the faulty publication(s) 

Any - pdf’s are not 
stored away in 
subfolders151 

Run AppleScript Cleanup PDF Repository. It 
will report on its activity. 

 
150 This script is only available if you have also installed the EndNote utilities as distributed within a disk image 
with name similar to EndNote SE Add Ons…. It also requires running SE_EN_Installer.command and 
SE_BD_Installer.command in this sequence. 
151 There may be several reasons for this to occur: First Folder Actions are not always reliably handling files 
entering a folder and once a file entered the folder, Folder Actions are no longer triggered. It could also be that 
BibDesk’s hook Did Auto File interfered with the Folder Action currently active for your pdf repository folder. 
To minimize the occurrence of such “abandoned” pdf’s, make sure you have Folder Actions enabled and that 
AppleScript Did_autofile.scpt is attached as a Folder Action for your pdf repository folder and that BibDesk’s 
hook Did Auto File does also use AppleScript Did_autofile.scpt. 
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A4 Selecting the correct reference type Ref_Type 

Especially when importing records from external sources such as ISI WOS, the field 
Ref_Type may require editing if it is not a Journal Article. The following table describes for 
all reference types the correct choice, in particular relevant for the more exotic types:  

 
Journal Article Scientific journal article 
Electronic Article Scientific journal article published in electronic form 

requiring to cite it via doi 
Newspaper Article Any non-scientific magazine or newspaper article 
Book A book that has an ordinary publisher and all has been 

written by the same authors and has NO EDITORS! 
In Book An individual chapter or section out of a book. NOTE: The 

authors are the same as for the entire book! Don’t 
confound with In Edited Book! 

Edited Articles A published collection of Journal Articles having editors 
typically bound as a book that represents a special issue of 
the scientific journal 

Edited Book Like a Book, but has editors 
In Edited Book An individual contribution to an Edited Book written by 

specific authors (who may or may not be the same persons 
as the editors) 

Thesis A work such as a master or PhD thesis as conducted at an 
university 

Map A work that is a map 
Report A work that has not been published by an institution (not a 

publisher) and has no editors 
Technical Report Same as the Report, but of a more technical nature, e.g. 

manuals or detailed model descriptions 
Edited Report * Like a Report but has editors 
Proceedings * Proceedings of a conference that can not be cited as an 

Edited Book 
In Proceedings * A work that is a contribution contained in Proceedings 
Booklet * A work that is printed and bound, but without a named 

publisher or sponsoring institution. 
Web page  
Unpublished * Unpublished work having an author and title 
Personal Communication Findings learned about through personal communications 

(oral testimony) 
Miscellaneous * A work that matches none of the above 

* use only as a last resort 

Note, the sequence matters: The earlier the reference type is listed, the more it is to be 
preferred in case of ambiguities. For instance, if a PhD thesis is published in a scientific 
journal, cite it as the latter and write only “PhD thesis” into the field Kind. If a report is 
published by an ordinary book publisher, favor Edited Book over Edited Report. If you can, 
favor Edited Book over Proceedings., regardless whether it is actually a Proceedings. 



Latest Additions Literature November 12, 2024 

98 

Similarly favor In Edited Book over In Proceedings, even if is actually a contribution to a 
Proceedings. These priority rules help to find the literature. 

Although our approach slightly differs, reference types were originally inspired by BibTEX 
(FISCHLIN & NEMECEK, 2001). Thus it may be useful to consult also: 
http://en.wikipedia.org/wiki/BibTeX  

http://en.wikipedia.org/wiki/BibTeX
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A5 ISI WOS hints (browser access) 

If you use ISI WOS (ISI Web Of Science now152, ISI Web Of Knowledge) at 
http://edc.isiknowledge.com/ 153 154 to search for literature and download that information to 
your personal FileMaker data base LiteratureMY, the following recommendations for 
choosing fields to download may be useful: 

 

If you register yourself at ISI WOS (recommended), you can also save these settings as your 
defaults (button ). Above field choice supports you optimally in maintaining 
information in your personal data base LiteratureMY. However, unfortunately, ISI WOS does 
NOT support DOIs. This means you need to copy the DOI manually after having downloaded 
the record from ISI WOS. To accomplish this you need to access the journal article with your 

browser, best by using the button  in ISI WOS. Once located select the DOI for 
each article, copy it into the clipboard, and paste it into LiteratureMY by choosing the menu 
command "Scripts -> Paste DOI" (see Section «New Helper Scripts»). 

 
152 July 2007 
153 This URL may frequently change. Consult our shadow home page for the latest URL to access ISI WOS at 
http://www.sysecol.ethz.ch/Internals.html  
154 The access to this service is restricted to ETH Zurich staff. At ETH Zurich it is most convenient to access 
this service by using the web proxy server proxy.ethz.ch by setting under Mac OS X the System Preferences for 
the Network as this:   

 

http://edc.isiknowledge.com/
http://www.sysecol.ethz.ch/Internals.html
http://www.proxy.ethz.ch/
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A6 On ISO/ANSI Standard Journal Abbreviations 

The AppleScript based utility LTWALookup.scpt is offered to search conveniently for an 
abbreviation for the term as is currently hold in the clipboard. The utility searches in a local 
copy of the LTWA table as offered by ISSN International Centre155 and as amended by all 
abbreviations offered previously in the table of this annex below and all contained in «How to 
work with EndNote». The utility LTWALookup.scpt returns whatever abbreviation it can find, 
again in the clipboard. If no abbreviation can be found the user is informed and the clipboard 
is left as it was before calling the utility. This utility is distributed via the disk image EndNote 
SE Add Ons…. Once the installer script has been executed it can be used independently from 
any other tool. E.g. I run it on my system with a shortcut (Cmd-Opt-A, A for abbreviation) 
using DragThing. Alternatively you could also install the AppleScript as an OS X wide 
service. 

Useful sources and links for standard journal abbreviations: 

FISCHLIN, 2001 Appendix H, p.40ff. («How to work with EndNote») 
http://cassi.cas.org/search.jsp156   (also available as one of the Hot URLs in LiteratureMY) 

http://www.issn.org/services/online-services/access-to-the-ltwa/157 (also available as one of 
the Hot URLs in LiteratureMY) 

http://www.issn.org/understanding-the-issn/standardization/ 
http://www.library.illinois.edu/bix/resources/journals/abbreviations.html 
http://atlantis.ncmr.gr/abbreva.htm 
http://home.ncifcrf.gov/research/bja/ 
http://library.caltech.edu/reference/abbreviations/ 
http://www.aeaweb.org/journal/abbrev.html 
http://www.public.iastate.edu/%7ECYBERSTACKS/JAS.htm 
http://www.wsl.ch/publikationen/abk_DE 

ISI WOS offers also huge lists of journal abbreviations. However, it is not possible to give 
here a direct link: Go to ISI WOS (http://apps.webofknowledge.com) and click on tab Cited 
Reference Search. On the search page underneath search field Cited Work you find a link 
named View abbreviation list.158  

For transparency reasons the table previously provided here is still listed below, but is 
considered to be frozen as of 1.Mar.2018 and will no longer be updated. If new terms may be 
added as part of the additions made to the LTWA table, e.g. because they are of particular 

 
155 http://www.issn.org/services/online-services/access-to-the-ltwa/  
156 Returns journal titles with their abbreviated titles, which generally adhere well to the ANSI standard 
157 LTWA is based on an ISO standard, and we have so far relied for abbreviations on an ANSI standard. While 
the two standards are very similar, be nevertheless careful, since occasionally the ISO may deviate from the 
ANSI standard. Ex.: The ANSI abbreviation for management is manage., not manag. as used in LTWA 
(accessed 19.Apr.2014). Not surprisingly, journals use different abbreviations and/or standards and 
consequently, e.g. ISI WOS (see below) lists journal abbreviations with both variants, i.e. MANAGE as well as 
MANAG. 
158 Last access 27.Feb.2018 

http://cassi.cas.org/search.jsp
http://www.issn.org/services/online-services/access-to-the-ltwa/
http://www.library.illinois.edu/bix/resources/journals/abbreviations.html
http://www.wsl.ch/publikationen/abk_DE
http://apps.webofknowledge.com/
http://www.issn.org/services/online-services/access-to-the-ltwa/
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interest to systems ecologists, those terms will only be made available through the utility 
LTWALookup.scpt.159 
Abbreviated Word ANSI/ISO 

Abbreviation160 
Little or not abbreviated 
form 

In specialiced J. used, 
strongly abbreviated 
(Jargon abbreviation)161 

Africa, African Afr.   
Assessment Assess.   
Biogeochemical Biogeochem.   
Change, Changes Chang. Change  
Comparative Comp.   
Cycles Cycles Cycles  
Fossil Foss.   
Frontiers Front.   
Global Glob. Global G, e.g. GCB (Glob. 

Chang. Biol.) 
Indian Indian Indian  
Integrative, Integral, 
Integrated 

Integr.   

Regional Reg.   
Resources Resour.   
Silviculture, Silvicultural, 
Silvicultura 

Silvic.   

Software Software Software  
Sustainable Sustainable Sustainable Sustain. 
Planetary, Planetarium Planet.   

 

 
159 The master file is ‘/Volumes/HD2/OrigsOfAFsProgs/OSX Shell Scripts/EN-Utils/LTWA/SE abbreviations 
(from Fi084 and Fi087) - edited6-UTF-8.txt’, which is maintained manually. The shell script ‘prepLTAW.sh’ 
constructs then from the latest LTWA as downloaded from http://www.issn.org/services/online-services/access-
to-the-ltwa/ the wanted lookup file, e.g. ‘LTWA_20160915-SE-UTF-8.txt’. 
160 To my knowledge the two standards ANSI and ISO are very compatible and deviate little from each other.  
161 Should be avoided and only used if well established and widely in use. Ex.: PNAS 

http://www.issn.org/services/online-services/access-to-the-ltwa/
http://www.issn.org/services/online-services/access-to-the-ltwa/
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A7 Troubleshooting hints 

Once all is well installed and configured, work flow should be smooth. However, there are 
complicated approaches necessary to get all the element cooperate with each other well, 
notably when transferring records. For a smooth operation and full coordination between the 
LiteratureMY system, AlphaX’ menu “EndNote”, EndNote, and BibDesk you should also 
ensure the following is consistent: 

a) ~/bin/LITMYPath.txt file is present, this is key, and exports environment variables  

- LITMY (denoting your work folder, e.g. where you keep your LiteratureMY 
FileMaker files),  

- LITUSER (e.g."af" or "dg") is consistent with what is defined in LiteratureMY,  
- MYPDFDIR1 and MYPDFDIR2, both denoting to your pdf's repository folders. 

Note, MYPDFDIR2 is used only if MYPDFDIR1 does not exist; this supports 
the use of up to two computers, e.g. your desktop Mac and your MacBook Air 
having slightly different absolute path to your pdf repository and 
moving/synchronizing your pdf's depository between them. Those environment 
variables are currently only used by this script and utility makeal (released as 
part of the so-called EndNote utilities, see SE Add Ons), but their use is 
reserved possibly also for other scripts) 

b) It is assumed you have per machine only one pdf repository folder (MYPDFDIR1 or 
MYPDFDIR2) 

c) It is assumed your pdf repository folders, i.e. MYPDFDIR1 and MYPDFDIR2, are 
both hierarchically structured as expected, i.e. they contain for each letter subfolders, 
where all pdf's are stored in the letter folder matching their first character. Such a 
folder is available as part of this release package. 

d) The preference of LiteratureMY (field 'hierarchy') should be set consistently with the 
actual structure of your pdf's repository folder, i.e. set to a value such as 1 (for sure 
not 0). Otherwise you risk to get unpredictable results, since LiteratureMY uses also 
an auto filing mechanism functioning according to the exact same rules as employed 
by the scripts ‘Did_autofile’ and/or ‘pdfwar - Store In Letter Folder’ and the ones 
LiteratureMY uses internally. 

e) The preference setting used by BibDesk "AutoFile -> File papers in fixed location" 
should be active and the folder chosen should be set consistently set to same folder 
as MYPDFDIR1 or MYPDFDIR2, respectively, point. Similarly LiteratureMY 
should also be set to use the very same depository folder. Use layout Configure 
PDF/WAR reading/downloading to choose it. 

As of this release, some scripts, notably “Did_autofile” and “pdfwar - Store In Letter Folder” 
maintain also a log of their actions, which is by default "~/myAutoFiling.log". In case of 
troubles you might find useful information there (albeit note, the flushing is not perfect and in 
case of crashes, some information may be missing from the log). All logging does only 
append, thus be aware, a lot of information may accumulate there. 

It may also be helpful to consult Appendix «A3 Transferring records among applications – 
possibilities and restrictions» 
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A8 Correspondence between EndNote, FileMaker, and BibDesk/BibTEX reference types 

The following table may be handy in knowing which EndNote reference type (field Reference 
Type) corresponds to which FileMaker reference type (field Ref_Type) and to which BibDesk 
or BibTEX, respectively, entry type (see also the similar table in Section «Exporting to 
BibTEX files», which is sorted by LiteratureMY fields).  

Reference types are tabulated below in alphabetical order of the original standard EndNote 
reference type regardless of renaming, i.e. SE customizations. If the reference type has been 
modified from the original (standard) EndNote reference type to match exactly the naming 
convention in LiteratureMY, i.e. SE customizations, the original (standard) EndNote reference 
type is also listed. Note, any reference types consisting of multiple words are separated 
always by hard blanks, not mere blanks and have therefore been customized even if otherwise 
the reference type appears unchanged. E.g. the common reference type Journal Article falls 
under this category162. This ensures proper searching for a particular reference type within 
FileMaker and unique mapping of reference types among the three systems. 

Yellow highlighted are reference types of particular interest. Transfers to watch out for are 
highlighted in light yellow. They may require some manual editing of the reference types 
once the transfer is complete, since no matching or no unique matching is possible among the 
three systems in all cases. Light brown colored are reference types introduced by EndNote 
versions beyond EndNote X1. Pink highlighted are changes made as of EndNote X7 and 
beyond. 
  

#163 EndNote X1 164 LiteratureMY‡ BibDesk165 
(BibTEX166) 

 Aggregated Database - - 
 Ancient Text - - 
 Artwork - - 
 Audiovisual Material - - 
 Bill - - 
 Blog - - 
6 Book Book book 167 
5 168 In Book† (Book Section) In Book inbook 169 

 
162 Due to limitations within EndNote this requires in import filters to enclose the %0 field, i.e. the reference 
type, within back quotes to ensure proper mapping of reference types during importing. Ex.: `Journal Article`. 
Otherwise you risk that imported records are not recognized properly and end up as reference type Generic. 
163 The numbers given here in the first column are the ones used to denote reference types in XML files (e.g. tag 
<ref-type>6</ref-type> denotes a Book; used file extension ‘.xml’). Such files are used either during export from 
or import to EndNote or when exporting from BibDesk, e.g. using AppleScript Export to EndNote.scpt. Since 
XML files can be opened by any ordinary text editor, those numbers may be useful for debugging transfers 
involving XML files. Note, these numbers differ from the IDs used by EndNote to define reference types, i.e. as used in 
file RefTypeTable.xml residing in ‘~/Library/Application Support’ in tags <RefType>. E.g. ID 5 in <RefType id="5" 
name="Newspaper Article">… differs from # 23 used to specify the record to be of reference type Newspaper Article. 
164 The table also lists reference types supported by EndNote versions later than X1. Those are highlighted in 
light brown. 
165 BibDesk is an open source application available from http://bibdesk.sourceforge.net/  
166 BibTEX standard reference types (entry types) are listed in bold. Other reference listed in this column are 
extensions to the BibTEX standard as offered by BibDesk (Version 1.3.21 (1525) or later) 
167 In this case a BibTEX field author instead of editor should be present in the record 

http://bibdesk.sourceforge.net/
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5 170 In Edited Book† (Book Section) In Edited Book incollection ⊕	
 Case - - 
 Catalog - - 
 Chart or Table - - 
 Classical Work - - 
9 Tech Report† (Computer 

Program) 
Tech Report manual 

47 In Proceedings† (Conference 
Paper) 

In Proceedings inproceedings, 
conference 171 

10 Proceedings† (Conference 
Proceedings) 

Proceedings proceedings 

 Dictionary - glossdef 
28 Edited Book† (Edited Book)⊖ Edited Book book 172 
43 Electronic Article† (Electronic Electronic Article 

173 
electronic 

 
168 Valid for all EndNote versions prior to EndNote X7 and prior to LiteratureMY 3.7r1 (see footnote⊕) 
† Edited reference type to match exactly the LiteratureMY’s reference type. The original (standard) EndNote 
reference type is given in parantheses. It determines the tabulation order. 
169 BibTEX‘s entry type inbook as well as LiteratureMY’s reference type In Book are both restricted to a book 
authored by the same author(s) as the cited section. Don’t confound this type with BibTEX‘s entry type 
incollection or LiteratureMY’s reference type In Edited Book, which are used for a contribution of authors in an 
edited book. Unfortunately EndNote does not differentiate these two cases and users often confound them. Our 
system always keeps the two cases clearly separate by mapping incollection exclusively to the SE custom 
EndNote reference type In Edited Book (Unused 1 prior to EndNote X7, Book Section as of EndNote X7, see 
footnote⊕). To avoid data loss in case of sharing EndNote libraries with colleagues, however, SE custom 
EndNote reference type In Book does tolerate a field Editor, which of course should remain empty for a true 
In Book reference. 
170 Valid as of EndNote X7 and as of LiteratureMY 3.7r1 and later versions (see footnote⊕) 
⊕ As of EndNote X7 (pink rows) the internal encoding of the SE custom EndNote reference types In Book was 
swapped with In Edited Book for better compatibility when sharing EndNote bibliography files with colleagues. 
Since the reference type In Book is considerably rarer than In Edited Book and EndNote uses internally by 
default for the latter reference type Book Section, this swapping enables in general for a much smoother sharing 
of bibliography files among colleagues. Neither redefining reference types in EndNote Xi nor editing of the 
reference type for all records with reference type In Edited Book is any longer needed.  
 Importing the reference type definitions from file SE EndNote RefTypes.xml as distributed within disk 
image EndNote SE Add Ons X7r01 or later versions will errenously change reference types of existing EndNote 
bibliography files made with the older system. As of EndNote X6 you can use menu command "Find and 
Replace…" to correct for this. E.g. follow these steps:  
 0) Check that library contains no references of reference type Custom;  
 1) Find those few where Reference Type is "In Edited Book";  
 2) Replace for find: "In Edited Book" -> "Custom";  
 3) Find all where Reference Type is "In Book"; 
 4) Replace for find: "In Book" -> "In Edited Book"; 
 5) Find all where Reference Type is "Custom"; 
 6) Replace for find: "Custom" -> "In Book". 
171 BibTEX‘s entry type conference is a synonym to inproceedings, not proceedings, and its purpose is outdated 
(http://nwalsh.com/tex/texhelp/bibtx-11.html). Our system does not use conference at all and I recommend 
against its use to avoid confusion. Use exclusively inproceedings. 
⊖ Notice that the original (standard) reference type of EndNote has a simple space between the two words. Since 
FileMaker requires for unique mapping a hard blank (character 202 decimal on a Macintosh, UTF-8 160, on Mac 
generated with key combination Option-Blank), this reference type had to be customized for a hard blank 
between the words. 
172 In this case a BibTEX field editor instead of author should be present in the record 

http://nwalsh.com/tex/texhelp/bibtx-11.html
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Article)⊖	
 Electronic Book - - 
 Electronic Book SEction - - 
 Encyclopedia - - 
 Equation - - 
 Figure - - 
 Film or Broadcast - - 
13 Generic Miscellaneous misc 
13 Generic 174 Booklet booklet 
 Government Document - - 
 Grant - - 
 Hearing - - 
 Interview - - 
17 Journal Article† (Journal 

Article)⊖ 
Journal Article article § 

 Legal Rule or Regulation - - 
 Magazine Article - - 
 Manuscript - - 
20 Map Map misc 175 
23 Newspaper Article Newspaper Article article § 
 Online Database - url 
 Online Multimedia - url 
24 Booklet 176† (Pamphlet) Booklet booklet 
25 Custom† (Patent) Custom 177 misc 
26 Personal Communication - 178 - 
 Podcast - - 
 Press Release - - 
27 Report Report techreport 
 Serial - periodical 

 
173 Newly supported reference type. Fields are to be treated the same as an ordinary Journal Article. This new 
reference type offers the following advantage: It allows you to distinguish two types of journal articles in the 
used Output Style of EndNote used to generate the list of references: For instance Journal Article’s without a 
DOI and Electronic Article’s with a DOI. 
174 In EndNote X1 reference types Booklet (LiteratureMY) and booklet (BibTEX, BibDesk) are mapped to the 
EndNote reference type Generic. Not so in later versions such as EndNote X3 or newer (see below). 
§ By default BibTEX can not distinguish between journal and newspaper articles. However, during exports from 
BibDesk of a record of this reference type, e.g. using AppleScript Export to EndNote.scpt, the presence of the 
optional field Newspaper (while mandatory field Journal remains empty) determines whether the exported 
record will obtain reference type Newspaper Article or Journal Article. 
175 BibTEX entry type misc encodes reference type Map (EndNote, LiteratureMY) if the record contains field 
Cartographer in place of standard BibTEX field author (BibDesk later than Version 1.3.21 (1525)). 
176 EndNote X1 recognizes not yet type Pamphlet and therefore any transfer between LiteratureMY and EndNote 
X1 requires a manual reassignment of the reference type after the transfer has been completed (here not 
highlighted in light red). Note, EndNote X2 has serious deficiencies relative to EndNote X1 and and I 
recommend strongly against its use. However, later versions, notably EndNote X3, X5, X6, and X7 are again 
generally fine and all distinguish the new EndNote reference type Booklet (factory reference type Pamphlet). 
177 Use reference type Custom in EndNote as a custom style you can customize freely to accommodate special 
needs of your publisher. 
178 Actually this reference type is tolerated and its transfer is fully supported between EndNote and 
LiteratureMY. However, it is recommended to enter a personal communication only within EndNote 
bibliographies and to avoid burdening LiteratureMY from storing records of such rather ephemeral nature. 



Latest Additions Literature November 12, 2024 

106 

 Standard - - 
 Statute - - 
32 Thesis Thesis masterthesis, 

phdthesis, jurthesis 
34 Unpublished Work Unpublished unpublished 
12 Web Page Web Page 179 webpage 
40 180 In Edited Book† (Unused 1) In Edited Book incollection 
40 181 In Book† (Unused 1) In Book inbook ⊕ 
41 Edited Report† (Unused 2) Edited Report report 
42 Edited Articles† (Unused 3) Edited Articles proceedings 

 
179 Newly supported reference type. The LiteratureMY field URL is mandatory and the LiteratureMY field No. 
may contain the access date. In case that field No. is empty, the LiteratureMY field Entry_Date is used as the 
access date. 
180 Valid for all EndNote versions prior to EndNote X7 and prior to LiteratureMY 3.7r1 (see footnote⊕) 
181 Valid as of EndNote X7 and as of LiteratureMY 3.7r1 and later versions (see footnote⊕) 
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A9 Correspondence between EndNote, FileMaker, and BibDesk/BibTEX fields 

The following table may be handy in knowing which EndNote field corresponds to which 
field in FileMaker and BibDesk. The red highlighted field is the main key that identifies each 
record. Yellow highlighted are field names, which are particularly important to remember 
well or which are not obvious, yet commonly used. Teal highlighted are fields that are new in 
EndNote X2 and EndNote X3. 

 
# Field Name in 

EndNote X. 182 
Field Name in 
LiteratureMY ‡ 

Field Name in 
BibDesk 183 

1 Reference Type Ref_Type entry type 184 
2 Author Authors author, 

cartographer 185 
3 Year Year year 
4 Title Title title 
5 Secondary Author Editors editor 186 
6 Secondary Title JOrPubl journal, booktitle 
7 Place Published City address 
8 Publisher Publisher publisher, 

organization, 
institution, school, 
howpublished 

9 Volume Vol volume 
10 Number of Volumes Microfiche custom5 * 
11 Number No. number 
12 Pages pp pages 
13 Section - - 
14 Tertiary Author SeriesEditor custom5 * 
15 Tertiary Title SeriesTitle series 
16 Edition Edition edition 
17 Date PlaceDate month 
18 Type of Work TypeOfWork type 
19 Subsidiary Author - - 
20 Short Title - - 
21 Alternate Title 187 - - 
22 ISBN/ISSN ISBN isbn 

 
182 Names as used in the reference type Generic as of EndNote X1 or later versions 
‡ This field correspondence is valid as of this writing for EndNote X1 (Bld 2377) or later versions (including 
EndNote X7 (Bld 9013) Version 17.0.0.9013) and LiteratureMY v3.0r2 (January 2008) or later versions 
(including v3.7r1) 
183 BibDesk supports any field names, but listed here are only those that are used by LiteratureMY when 
exporting to BibTEX  
184 Has actually no special field name and is the first identifier used in the record 
185 To encode reference type Map (EndNote, LiteratureMY) you can use in BibDesk (later than Version 1.3.21 
(1525)) the field Cartographer in place of standard BibTEX field author. 
186 BibTEX entry type book encodes the reference type Book or Edited Book (EndNote, LiteratureMY), 
respectively, depending whether the record contains a field author or editor. 
* Field custom5 is reserved for internal use while transferring records back and forth between BibDesk and 
LiteratureMY via EndNote. 
187 May be used for internal purposes in case of reference type Generic 
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23 DOI DOI doi 188 
24 Original Publication - - 
25 Reprint Edition - - 
26 Reviewed Item Owners custom5 * 
27 Custom 1 Users custom5 * 
28 Custom 2 Ref_Status custom5 * 
29 Custom 3 Entry_Date custom5 * 
30 Custom 4 Modified custom5 * 
31 Custom 5 - custom5 * 
32 Custom 6 Custom_6 custom5 * 
33 Custom 7 Custom_7 custom5 * 
34 Accession Number - - 
35 Call Number Bibl. custom5 * 
36 Label SysEcolCode cite key 
37 Keywords Keywords keywords 
38 Abstract Summary abstract 
39 Notes Project, InUseFor, 

StoragePlace, 
InCrdIndex 189 

annote 

40 Research Notes Comments 190 annote 
41 URL URL url   

(Bdsk-Url-1, -2 …) 191 
42 File Attachments pdf_pathfilename_URL local-url  

(Bdsk-File-1 …) 192 
43 Author Address - - 
44 Figure - - 
45 Caption - - 
46 Access Date - - 
47 Last Modified Date193 - - 
48 Translated Author - - 
49 Translated Title - - 

 
188 Since the field Doi may also represent an URL, e.g. http://dx.doi.org/<DOI>, or hold alternatively an URL, 
this field is also involved in BibDesk’s conversions of file and URL fields. Thus, the presence of this field 
depends on the mode of conversion: Conversion with keeping so-called local URLs preserves this field, a 
conversion without keeping it will remove it and replace it by fields named Bdsk-Url-1, Bdsk-Url-2 etc. 
Transferring a DOI URL stored in such a field Bdsk-Url-1 to LiteratureMY will reconstruct the content of the 
field DOI. 
189 For legacy reasons all these fields are stored in BibTEX field note using a specific keyword 
190 When exporting from LiteratureMY to EndNote, field Comments ends up in EndNote’s field Research Notes. 
When exporting from LiteratureMY to BibTEX, field Comments ends up in BibDesks’ field annote. When 
importing into LiteratureMY, EndNote’s field Notes as well as Research Notes (or BibTEX‘s note and annote, 
respectively) are both merged into LiteratureMY’s field Comments. 
191 URLs of web sites are here entered as e.g. “http://www.sysecol.ethz.ch“. However, when using BibDesk, the 
presence of these fields depends on the mode of conversion of file and URL fields: Conversion with keeping so-
called local URLs preserves this field, a conversion without keeping it will remove it and replace it by fields 
named Bdsk-Url-1, Bdsk-Url-2 etc. BibDesk lists these fields under the heading Remote URLs. 
192 Links to pdfs are here entered as so-called file URLs, e.g. 
file://localhost/Volumes/HD/uaf/Data%20Bases/AFEles/afEles_AFCD100/F/Fi103.pdf. Normally BibDesk 
(1.3.21 (1525)) automatically converts this to the internally used file linking scheme, which can also safely be 
exported to EndNote’s File Attachments and from there to LiteratureMY. Once converted by BibDesk, this field 
is normally removed and replaced by fields Bdsk-File-1, Bdsk-File-2 etc., BibDesk lists these fields under the 
heading Local Files.  
193 Replaced by new field ‘Custom 8’ as of EndNote X2 and becomes field ‘Last Updated’ at position 54 
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50 Name of Database - - 
51 Database Provider - - 
52 Language - - 
53 C Added to Library - - 
54 C Last Updated194 - - 

 
C New field only available as of EndNote X2 or later versions 
194 Former field Last Modified Date as used in EndNote X1 
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A10  Reference types and used field names 

This describes the differences in naming of the various EndNote fields as used by the 
supported reference types. These names were chosen for easier recognition of the fields as 
used in the FileMaker data base LiteratureMY and to correct for inconsistencies and 
deficiencies in the default use of some fields by EndNote 195. These modifications are 
available in the file SE EndNote RefTypes.xml (see released dmg-file EndNote SE Add Ons). 

The following table lists the used field names, which are used for all reference types: 
 

Generic field name Used field name (in all reference types) 
Reviewed Item Owners 
Custom 1 Users 
Custom 2 RefStatus 
Custom 3 EntryDate 
Custom 4 ModifyDate 
Custom 5 Microfiche 
Label SysEcolCode 
File Attachments (Link to PDF) Link to PDF 

The following lists some commonly used and critical field names, which are only used for 
specific reference types: 
 

Reference type Generic field name Used field name 
Journal_Article196 Publisher Abbreviated J 
Newspaper_Article Publisher Abbreviated 

Newspaper 
Edited_Articles Publisher Abbreviated J 

 

 
195 Depending on the reference type, EndNote ’s default uses different fields for the same content, i.e. Series 
Editor or Series Title. The SE modification of reference types attempts to simplify transfers from LiteratureMY 
to EndNote  and vice versa by using fields more consistently and by correcting for other citation difficulties 
present in EndNote ’s defaults.  
196 Note that the underscore character actually denotes a hard blank (character 202 decimal on a Macintosh, 
UTF-8 160, on Mac generated with key combination Option-Blank) 
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A11 Importing: EndNote  tags and corresponding fields (from EndNote  manual) 

The table below shows the tags recognized in the EndNote import format and the 
corresponding EndNote field into which each tagged item is imported for the Generic 
reference type. For other reference types, many fields may be mapped to the Notes field 
(since a limited number of fields are typically used by each reference type). The Figure field 
is not included for importing as our system does not suppor that. 
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However this list as shown similarly in EndNote manuals is not fully correct for later versions 
than EndNote X1: 

First, the tag %O for field Alternate Title supported as of EndNote X2 and later versions is on 
purpose not listed in above table, since algorithms in our system swap the tags %O and %Z 
for backward compatibility reasons with older EndNote versions197. Currently our system still 
uses for field Notes tag %O and uses for field Alternate Title tag %Z. 

As of EndNote X7 the tag %= is listed as Custom 8 and no longer Last Modified Date. 

See also Max Planck digital library web page «PubMan Func Spec Endnote Mapping»198 

 
197 Required considerably less changes in the cumbersome EndNote customizations as needed to overcome 
EndNote’s deficiencies and bugs (and as provided via the files contained in EndNote SE Add Ons…) 
198 As of 27.Oct.2015 http://colab.mpdl.mpg.de/mediawiki/PubMan_Func_Spec_Endnote_Mapping  

http://colab.mpdl.mpg.de/mediawiki/PubMan_Func_Spec_Endnote_Mapping
http://colab.mpdl.mpg.de/mediawiki/PubMan_Func_Spec_Endnote_Mapping
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A12 Searching in BibDesk – Query Syntax Summaries 
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Some PubMed fields 

 

Searches are case insensitive, boolean expressions can contain AND, OR, and parantheses. 
Ex.: “Fischlin A” [au] AND (forest [TIAB] OR insect* [all]) 
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Web of Science Searching Syntax 

Wildcard symbols Proximity operators 

           

Boolean operators 

 

Common search fields 
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A13 Using Mendeley 

Mendeley has become popular lately and institutions such as ETH Zurich libraries even 
recommend the use of Mendeley. Mendeley has some strength such as syncing between 
devices, however, Mendeley has also many serious flaws. In a setup like ours these flaws are 
very fatal and preclude a professional use of Mendeley. This is somewhat similar to EndNote 
but the flexibilities in terms of customization of EndNote are larger and make it possible to 
circumvent its flaws while maintaining proper control over the content of the data base, 
justifying the full support for EndNote as done here. That is not the case for Mendeley, which 
makes it very difficult to control its content, which is partly due to just the downside of its 
syncing strength.  

As of this writing Mendeleyà contains many bugs, yet it can be used to share a bibliography 
among authors if certain rules are observed.  The following assumes a scenario where LaTEX 
is used for writing an article by a team of authors and an article specific BibTEX file is used 
for the references. It is also assumed that some if not all records are entered using Mendeley. 
In any case the goal is to have shared Mendeley data base that is consistent with the BibTEX 
file. 

(i) Create in Mendeley a project specific group to which all co-authors belong.  
(ii) Create within that group two folders ‘Acquired’ and ‘Fixed’ and ask all group 

members to enter any records only to ‘Acquired’. The folder ‘Fixed’ must contain 
only cleaned up records.  

(iii) Mendely BibTEX preferences should be set similar to this: 

 
Checking the checkbox ‘Escape LaTeX special characters (${}%& etc.)’ means a 
TEX encoding for direct LaTEX use similar to the BibDesk preference ‘Convert 
accented characters to TeX when exporting or pasting BibTeX’ tab ‘Opening and 
Saving’. However, note that the encoding used by Mendeley is incompatible with 

 
à Mendeley Desktop Version 1.15.2 and Mendeley iOS App 2.8.1, 3.Feb.2016 
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the one BibDesk uses. E.g. Umlaut ‘ü’ is written by Mendeley as ‘{\"{u}}’, 
whereas BibDesk writes this as ‘{\"u}’. Opening a Mendeley created bib-file – as 
results from checking option ‘Enable BibTeX syncing’ – does then not properly 
display such special characters. 

(iv) Regularly empty the automatically created and updated BibTEX file ‘<group 
name>-Acquired.bib’ (named after the group and its folder ‘Acquired’, residing in 
the directory given by preference Path) and process the newly acquired records the 
usual way by transferring them to LiteratureMY. 

(v) Once cleaned up transfer the records to any temporary BibTEX file and import all 
records back into Mendeley ’s group ‘Fixed’ using menu command “File -> 
Import… -> BibTeX (*.bib)” (see below for details). 

(vi) The records are now available in the BibTEX-file ‘<group name>-Fixed.bib’ and 
are automatically written, i.e. one-way synced, to that file by Mendeley. This is 
quite a useful solution, since this file can typically directly be used by LaTEX for 
typesetting199. However, note, this file resides in the directory given by Mendeley 
Desktop preference Path (seea bove), which may not be the wanted directory 
where you currently work with LaTEX, i.e. your LaTEX work folder. In such cases 
I recommend to use a symbolic link in the LaTEX work folder pointing to ‘<group 
name>-Fixed.bib’ as maintained automatically by Mendeley200. 

Other preferences may matter as well, notably make sure ‘Ciation Key’ is enabled/checked in 
preference ‘Document Details’ for all reference types similar to this: 

 
 

199 Critical problems may arise however due to incompatible reference types and special character encoding. 
The former is due to the fact that Mendeley’s set of reference types is lacking quite important reference types 
such as 'In Edited Book’ (BibTEX entry type ‘incollection’) or ‘In Proceedings’ (BibTEX entry type 
‘inproceedings' and is often faulty in terms of how it handles reference types (problematic are BibTEX entry 
types ‘mastersthesis’, ‘misc’, ‘phdthesis’, ‘proceedings’, and ‘unpublished’).  Special characters may appear as 
garbled up UTF-8 characters, since Mendeley fails to properly code all these.  
200 Note that it does not help to edit the BibTEX file ‘<group name>-Fixed.bib’, e.g. to fix a bad reference type, 
or a buggy encoding, since Mendeley will overwrite its content at regular intervals. Even additionally imported 
records, which are not contained in Mendeley are deleted by Mendeley. Thus you have to live with whatever 
Mendeley does to that file and hope you can nevertheless typeset your LaTEX document. If that’s impossible 
(see above) then the only remedy is to have a separate copy of the BibTEX file in your LaTEX work folder. That 
may in general be the safest and therefore most recommendable work setup. 
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Convenient shortcuts201, since often used menu commands, are: 

 

Importing records into Mendeley is very difficult, since Mendeley does not want to give up on 
records once entered and insists on reinserting wrong meta data, hereby overwriting corrected 
meta-data and one has otherwise great difficulties in getting rid of records. After long testing 
and making efforts to circumvent this buggy behavior the following, admitted quite 
cumbersome procedure, is recommended: 

1) Delete the records in Mendeley Desktop you wish to reimport. Yes, indeed, this is 
very tedious, but it seems unavoidable. Note deleting does not work right away and is 
a tedious process. Fortunately the latest version of Mendeley Desktop as of this 
writing† has made it a bit clearer what is going on and seems also to work more 
reliable during deletion. First you need to select the records you wish to delete. Do not 
hit backspace, or you will merely remove the records from the folder in case the 
selected records are in a folder such as ‘Acquired’ or ‘Fixed’. Instead choose menu 
command “File -> Delete Documents”. The records are now moved to the Mendeley 
Trash. Secondly select the ‘All Deleted Documents’ under TRASH  

 
 
Thirdly choose menu command “File -> Empty Trash” and fourthly answer the 
resulting dialog with ‘Delete Documents’ (unfortunately not the default)  

 
201 Note, shortcut ‘Open File Externally’ does unfortunately not work as it is a contextual menu command. 
† Mendeley 1.16.1 has improved here by no longer offering a Trash button, since the deletion while a folder is 
selected means not deletion, but removal from the folder only (observed early April 2016). 
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Note also that any linked files are not actually deleted. They are merely moved to a 
folder ‘Archive’202. While this is fine in terms of keeping possibly annotated files 
save, this may consume quite a bit of storage if pdf’s accumulate there, e.g. during 
reimporting. 
 
The entire deletion process is quite tedious and time consuming. However, at least it 
seems now to work reliably in contrast to earlier versions of Mendeley.† 
 
Even now you can not be sure to have really deleted all documents (see next steps 2 
and 3). 
 

2) Sync to the cloud repository. This is necessary to really get rid of the deleted 
records. However, often records do still survive in the cloud and your local data base, 
but are not properly displayed. Such records are here nicknamed “Zombie” records. 
To be really safe that all records, including “Zombie” records, are deleted, I 
recommend to sync also to an iPad. There you should see reliably all not yet fully 
deleted Zombie records outside the any folders of the group such as ‘Acquired’ and 
‘Fixed’. 
 

3) Delete “Zombie” records using Mendeley Desktop: Use the global search facility 
(top right corner) in Mendeley Desktop to be able to select the “Zombie” records. E.g. 
search by author or title portion. Note, the “Zombie” records are typically not visible 
in any of the ordinary views of the group’s folders and may also contain wrong meta 
data. Repeat previous steps until you find no more “Zombie” records. Sometimes 
“Zombie” records are not even searchable and repeated quit/relaunch cycles while 
always syncing to the cloud may be necessary. The most reliable solution for making 
sure you have really all “Zombie” records deleted is to see in the iOS App Mendeley 
whether some “Zombie” records are still in the data base. Note in Mendeley Desktop 
the number of records shown in the group and all its folders does not change upon 
deleting a “Zombie” record. 
 
With latest version of Mendeley Deskopt as of this writing†, this problem may have be 
gone or at least lessened. However, without full deletion, indeed wrong meta data are 
merged into a just imported record and corrections of bad meta data through 
reimporting is still impossible. 
 

4) Prepare your records in form of a UTF-8 encoded BibTEX file. If you work as 
recommended normally with 'Western (MacOS Roman)’ encoding then you need to 
convert the BibTEX file first. You could use e.g. utility ‘iconv’ or ‘mac2utf8’ but the 
most convenient technique is to export the file from BibDesk in UTF-8 encoding 
menu command “File -> Export…” and check possibly the box ‘Only export selected 
items’ as you wish. If you miss out on this step you risk that Mendeley will contain 
corrupted special characters, e.g. Umlaute or other special characters will not be 

 
202 On my system this folder is ~/Documents/DataBases/AFEles/Mendeley pdf's/Archive/ as set in Mendeley 
preference ‘File Organizer’. 



Latest Additions Literature November 12, 2024 

120 

correctly displayed but look like the ugly � (see for keywords, journal names etc.) 
and a tedious manual deletion will be required as described above. Note also, since 
Mendeley does not properly decode TEX code, that you must not have the BibDesk 
preference ‘Convert accented characters to TeX when exporting or pasting BibTeX’ 
checked. Fortunately Mendeley can at least correctly import UTF-8 encoded files. 
 

5) Make sure the BibDesk preference ‘Remove converted Local File fields’ of tab 
‘Default Fields’ in section ‘Converting File and URL’ is unchecked. If checked 
Mendeley will ignore any attached files. Note, Mendeley as of this writing† ignores all 
remotely linked files. It can only recognize the local file field ‘Local-URL’. Thus it is 
prefereable to have always that preference unchecked when working with Mendeley. 
 

6) Only now will you be able to successfully import the records into Mendeley Desktop 
using menu command “File -> Import… -> BibTeX (*.bib)”and sync.  

All of above idiosyncracies and bugs in Mendeley were observed as of this writing with the 
versions as described in this footnoteà. 

Another problem is the fact that Mendeley will nevertheless transmogrify the meta data. 
Critical reference types are missing, authors will not be represented correctly in many cases, 
e.g. complex von parts, treatment of special characters is buggy, and most annoyingly 
Mendeley insists on ignoring your cite keys upon syncing. The latter is of course terrible and 
makes the use of Mendeley for some professional work impossible and means that you can 
never relate corresponding records properly by cite key between an iOS device and your 
Mendeley Desktop. E.g. it is not possible to find a record on your iPad by its cite key! This 
behavior is of course against all data base theory and any decent data base software should 
never allow for such a behavior. Moreoever, this is also particularly bad for pdf’s, which are 
renamed upon syncing and can never be properly maintained, e.g. if you would like to use 
another, more powerful App for annotations such as GoodReader.  

The worst property of a reference manager is when it is a one-way application. Fortunately, 
Mendeley offers now rather good export facilites, e.g. its export to a BibTEX file is not bad. 
Unfortunately, the result is however not that compatible to our system when it comes to 
special characters. They may not be readable in BibDesk, e.g. if TEX encoding is used in 
Mendeley (see above), This is because Mendeley uses unfortunately another format than 
BibDesk, i.e. Umlaute such as ‘ö’ are coded as ‘\”{o}’, whereas BibDesk uses ‘{\”o}’. And if 
UTF-8 encoding would be used by Mendeley (option ‘Escape LaTeX special characters 
(${}%& etc.)’ unchecked) then we have another conflict with our default encoding used by 
BibDesk, i.e. ‘Western (Mac OS Roman)’. 

The main argument against Mendeley is, however, its ignorance of a proper data base 
management by not honoring user specified cite keys, notably when it comes to a strength of 
Mendeley, i.e. syncing across devices. The aforementioned difficulties to get rid of records 
may be merely related to this problem of not honoring cite keys as a main key of the data 
base. What Mendeley should do instead is to honor user entered cite keys throughout the 
system and across all devices. Mendeley is so bad that it does not even sync cite keys via an 
extra field or in the note field across all devices. As a consequence, you cannot find a record 
on an iPad if you know that record’s cite key! Mendeley should also accept any user provided 
input data as resulting from imports when cite keys match, which would make any 
cumbersome deletion of records superfluous, and Mendeley should refrain from overwriting 
user corrected meta data with wrong data from the cloud or from internal meta data archives. 
Only then would the foundation of Mendeley be sufficiently solid and Mendeley could be 
recommended for professional use, since there would be good reasons for hope that the many 
other bugs currently present might be removed at some point in the future. 
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A14 Kindle e-books 

Non-fiction books are typically listed in my FileMaker data base LiteratureMY and have 
therefore a SECode (cite key). All those azw-files have a symlink in the PDF repository 
named after the original file and the SECode. E.g. 

 Or032.azw 

points to file 

 B003RRXXO8_EBOK.azw 

in the folder 
 /Users/afischli/Library/Containers/com.amazon.Kindle/Data/Library/Applicati

on Support/Kindle/My Kindle Content 

or if I should have renamed the file to a memnomically easier name e.g. to 
 Or032-B003RRXXO8_EBOK-Oreskes-2010-Merchants_of_doubt.azw 

In addition to the symbolic links there are also kept zip archives of the originally named set of 
files within the PDF repository as well as the ‘My Kindle Content’ folder. All the files 
involved should be tagged green for easier recognition. 

All of above is very easy to accomplish by FileMaker scripts offering two little buttons in the 
top right corner of the standard layout: 

  and  

They operate on individual files and can rename the files according to above rules, tag them, 
create symbolic links and all zip files. See shell scripts 

 ~/bin/manageMyKindleBooks.sh 

 ~/bin/settag.sh 

Moreover, LiteratureMY can find all Kindle books and offers FileMaker scripts that operate 
on entire current sets as a convenient alternative to the aforementioned buttons. As an 
important result BibDesk and LiteratureMY can then find those files and open the e-Book in 
the application Kindle. 

LiteratureMY contains a FileMaker script «Personal Finds -> Find my Kindle e-books» to 
search for all Kindle e-books. As of this writing (28.Jun.2016) these are in LiteratureAF: 

 Fr095, Fr120, Ha465, Ma568, Ma572, Nu015, Or032, Or036, Ra200, Ri153, 
Sche042, Schu049, Va147 

All these records must contain the so-called Kindle code in the 3rd repetition and the name 
suffix in 4th repetition of field ‘Bibl.’. Ex.: 

 Or032-B003RRXXO8_EBOK-Oreskes-2010-Merchants_of_doubt.azw 

The red part is stored in repetition 3 and the blue part in repetition 4 of FileMaker field 
‘Bibl.’. Otherwise the FileMaker scripts will not succeed. Upon first time use of button  or 
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FileMaker script «Set custom format for current set of Kindle E-books» the user is offered a 
dialog for each Kindle book to enter those data. 

Following caveats apply:  The application Kindle seems to tolerate the renaming, given the 
renaming happens while Kindle is not running (manageMyKindleBooks.sh automatically quits 
the application Kindle). However, I believe having once observed that Kindle would change 
the code it uses for a book (red part). Latest testing using a Mac (OS X 10.9.5 Mavericks) and 
an iPad, however, showed no problem and syncing back and forth worked well.  

•  Yet, annotations can get lost. The remedy may then be to extract the files from one 
of the zip archives, again while Kindle is not running (option -x of  
manageMyKindleBooks.sh) or to remove the book from the device from within 
Kindle and redownload it from Amazon. In some cases I had to do the latter, since 
the accompanying files in the zip archive containing the annotations were already the 
wrong ones. 

•  Books may become archived, e.g. was the case for Fr120. This means the file is 
recorded by Kindle to have been removed from my Mac. With renaming there is a 
risk that you may end up with a double entry of the same book within Kindle. This 
requires of course manual fixing, which may involve similar actions as described 
above. 

•  Amazon clears out all content upon logout/deregistering (menu command “Kindle -> 
Preferences… -> Deregister (button)”). This is one reason to keep a zip archive. 
However, the readability is not warranted. For some books, e.g. Va147, which I had 
to buy not in my main Amazon account but in the German Amazon store, cannot be 
opened when application Kindle is registered to my main account. However, this is 
not symmetric. While I am registered to the German Amazon store I can read the 
books that I bought in the main Amazon store.203 

Note, a zip such as  
 ‘Schu049-B003JBHW08_EBOK-Schulz-2010-Being_wrong.zip’ 

contains 
 B003JBHW08_EBOK.apnx 

 B003JBHW08_EBOK.azw 

 B003JBHW08_EBOK.mbpV2 

 
203 This behavior is not necessary reproducible according to my observations. Sometimes a Kindle e-book can at 
least be opened, even if the annotations got lost and despite the fact that it was purchased in another store than 
the current one. Sometimes that very same book can even be opened with all annotations intact despite the fact it 
was purchased in another store than the current one. Sometimes the very same book cannot even be opened and 
the application Kindle insists on me removing this particular e-book from the device and then to redownload it 
before opening becomes possible again. The reasons for these differences escape me. On the other hand these 
observations clearly indicate that read access is not only controlled by the involved files themeselves, but also by 
additional data used by Kindle. It would be useful to understand that better and to store that metadata as well in 
the zip archives generated by utility manageMyKindleBooks.sh in order to be able gain some minimal control 
over purchased e-books (An SQLite data base exists within folder ‘~/Library/Containers/com.amazon.Kindle/ 
Data/Library/Application Support/Kindle/Cache/db’). Note, all this applies only to the application Kindle on a 
Mac. On an iPad there is no option to leave e-books purchased on the device when going through a de-
reregistering cycle. As of this writing (29.Jun.2016) the application Kindle Kindle (version 1.12.4 41014) offers 
(still?) the possibility to uncheck the check box “Remove all licensed content from this device” when 
deregistering. 
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 B003JBHW08_EBOK.phl 

Since the Kindle application immediately assumes a file is new as soon as its file has been 
renamed, it is advisable to make on the very last page of any book a bookmark that states 
whether the book has actually been read or is really new. Best to add also the date of 
completing the reading. 



Latest Additions Literature November 12, 2024 

124 

References 

DELLAVALLE, R.P., HESTER, E.J., HEILIG, L.F., DRAKE, A.L., KUNTZMAN, J.W., GRABER, M. 
& SCHILLING, L.M., 2003. Information science - Going, going, gone: Lost Internet 
references. Science, 302(5646): 787-788. 

FISCHLIN, A. & NEMECEK, T., 2001. Literaturverwaltung der Fachgruppe Systemökologie ITÖ 
/ D-UMNW / ETH Zürich. Terrestrial Systems Ecology, Department of Environmental 
Sciences, ETH Zurich, Switzerland, 49 pp.  

FISCHLIN, A., 2001. How to Work With EndNote - Tutorial and Reference. Terrestrial Systems 
Ecology, Department of Environmental Sciences, ETH Zurich, Switzerland, 56 pp.  

KOPKA, H. & DALY, P.W., 2003 (4 ed.). Guide to LaTeX. Addison-Wesley: Bonn a.o., 597 pp. 

PATASHNIK, O., 1988. BibTeXing. Center for Communications Research: La Jolla, USA, 
16 pp.  (http://en.wikipedia.org/wiki/BibTeX) 

 


